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About this Guide
This User’s reference guide describes how to install and maintain the Nortel Symposium Desktop TAPI Service
Provider 1.5.  Information in this document is intended for use by telephony server administrators and
developers who are responsible for installing, configuring, maintaining and using Nortel’s TAPI SP.  This
document is written based upon the assumption that you have some experience working with computers, TAPI,
telephony products, and Microsoft Windows.  The Nortel Symposium Desktop TAPI Service Provider 1.5 is
referred to as Nortel’s TAPI SP 1.5 in this guide.

Note: Nortel Symposium Desktop TAPI Service Provider software contains a README.TXT file.  This file
provides information not available when this document was printed.  Always read this information prior to
beginning installation.

This guide is divided into the following chapters and appendices:

Chapter 1, “Overview,”  provides a summary of  TAPI and of the Nortel Symposium Desktop TAPI Service
Provider 1.5.

Chapter 2, “Installing,” describes in detail how to complete the installation of the Nortel Symposium
Desktop TAPI Service Provider 1.5.

Chapter 3, “Configuring,” provides information on configuring the Nortel Symposium Desktop TAPI
Service Provider 1.5.

Chapter 4, “Troubleshooting Tips,” provides information for additional installation acceptance testing using
the TAPI Test Tool and for running the Logger Tool.  In addition, it also describes possible problems
and the actions to resolve these problems.

Appendix A provides additional user information.  This information includes how to receive technical
support, a summary of the online documents, and information on using the Adobe Acrobat Reader to
view the online documentation.  To view and to print the online documents, the Adobe Acrobat Reader
must be installed.

Appendix B identifies the features that the Nortel Symposium TAPI Service Provider supports.

In addition, this guide contains a Glossary that lists telephony services terms and definitions used in this
document.  A Table of Contents and Index  provide assist you in locating the desired information.

For additional information or help, call the Nortel Developer Support Hotline at
(800) NT-4CTI-0.

For information about other Northern Telecom products, call (800) 4-NORTEL (466-7835).  Outside the United
States and Canada, contact your Nortel Support or Sales representative.

Note:  This document can not be ordered from Northern Telcom using the Publication number on the inside
cover page.  This document is only available online with the software or from the Nortel web site,
www.nortel.com/bap/sales.htm, and click on the Symposium Desktop TAPI SP.
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Document Conventions
The following conventions are used in this document:

1. The individual keys that users are instructed to press appear inside angle brackets.
For example: <Enter> or <F1>

2. “Press,” “ Choose,” or “Click on” means to position the cursor over an option, then press and release
the left mouse button to activate control and carry out an action.

3. "Select" means to position the cursor over an option, then press and release the left mouse button to
highlight the selection.

4. "Double click" means to position the cursor over an option, then press and release the left mouse
button twice.

5. Information that users are instructed to type appears in bold, italic print.
For example:  Type User Id  or  Enter User Id

6. Menu commands and options that are displayed on the window appear in bold print, such as the Exit
option located on the File menu on the Menu bar.

7. Window, screen, dialog box, or data entry field names display in italic print, such as, the Open field on
the Run dialog box.

8. “Button” refers to a click or push button displayed on the window that is clicked on or pressed to carry

out an action.  For example:  Click on the OK  button  or  Click on 

9. “Check box”  refers to a square box displayed on the window that is clicked on to select or to clear an
option.  For example:  � -- option not selected  or  _ -- option selected

10. “Option button”  refers to a circle displayed on the window that is clicked on to select or to clear an

option.  For example:  { -- option is not selected  or  m -- option is selected

11. Note: Identifies important User information and special instructions.

Note:  Notes display in paragraphs separated from other text.
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Related Documents
Documents that you may need to reference, but are not necessarily required for configuring or using the TAPI
SP include:

• Meridian TelAdaptor TCM Installation Guide - Available from Nortel, Publication # P0741589

• VISIT Technical Reference Guide - Available from Nortel, Publication #P0739491

• MS-Windows User’s Guide - Available from Microsoft Corporation

• MS-DOS User’s Guide - Available from Microsoft Corporation

• Nortel Symposium Desktop TAPI Service Provider 1.5 Implementation Planning Guide - Available
from Nortel - Available from the Nortel Web Site (www.nortel.com/bap/sales.htm) with the Nortel
Symposium Desktop TAPI SP Developer Tool Kit.

• Nortel Symposium Desktop TAPI Service Provider 1.5 Programmer’s Guide - Available from the
Nortel Web Site (www.nortel.com/bap/sales.htm) with the Nortel Symposium Desktop TAPI SP
Developer Tool Kit.

• Getting Started with Nortel Symposium Communicator - Available with Nortel Symposium
Communicator product.

• Getting Started with Nortel Symposium Multimedia Conferencing - Available with the Nortel
Symposium Multimedia Conferencing product.

• Getting started with Nortel Symposium Call Manager - Available with the Nortel Symposium Call
Manager product.
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Chapter 1  Overview

The chapter provides a summary of  TAPI and of the Nortel Symposium Desktop TAPI Service Provider 1.5.

Overview of TAPI
The introduction of new computer telephony integration (CTI) standards allows businesses of all sizes to
develop new applications integrating computers and telephone systems.  Microsoft and Intel created Telephony
Application Programming Interface (TAPI).  The Telephony technology integrates computers with the telephone
network.

Nortel offers TAPI compliant applications as well as Service Providers.  Service Providers (SP) are the software
files needed to enable TAPI applications to communicate with the physical telephony device.  Nortel offers
TAPI SPs for Meridian 1, Norstar, MSL-100, DMS Meridian Digital Centrex business systems.

Figure 1  TAPI Overview

The Nortel Symposium Desktop TAPI service providers, available as standalone development kits, are capable
of being included in a variety of applications.   The Telephony Application Programming Interface (TAPI) gives
developers a consistent set of tools for creating the windows-based telephony applications.

In addition, Nortel now offers the Nortel Symposium Desktop TAPI SP software for Meridian 1 that runs on a
Windows NT Server and supports a Telephony Application Programming Interface on a Windows client.   Refer
to the Nortel Symposium Desktop TAPI SP documentation for additional information on this product.
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Overview of the Nortel Symposium Desktop TAPI
Service Provider 1.5

The Nortel Symposium Desktop Telephony Application Programming Interface (TAPI) Service Provider (SP)
release 1.5 is also referred to as Nortel’s TAPI SP 1.5 in this document.  Along with the standard features
included in Version 1.0 of the TAPI Service Provider, Nortel’s TAPI SP version 1.5 allows Nortel’s TAPI SP
1.5 to function in the Symposium Call Center Server (SCCS) environment on the Meridian 1 with MCA and
Nortel Symposium Communicator card interface devices.

In addition, the Nortel Symposium Desktop TAPI Service Provider 1.5 provides the new TAPI Test tool and the
TAPI Logger tool to help with troubleshooting.  The TAPI Test Tool is provided to assist you in verifying that
Nortel’s TAPI SP 1.5 is working after it is installed and configured.  The Logger tool allows you to create a log
file that provides information to assist technical personnel in troubleshooting problems.  These tools are detailed
in Chapter 4 of the online Nortel Symposium TAPI Service Provider 1.5 User’s Guide.

TAPI Application Relationships
Figure 2 shows the relationship between Microsoft TAPI, Nortel TAPI SPs, and TAPI applications.

Figure 2  TAPI Application Relationships

Implementation Planning Process
The process of implementation planning starts by determining what you want to do and how your TAPI
application will help you do it.  You need to determine how the TAPI application can take advantage of the
information presented to the set.  Keep in mind that most applications that are compatible with Microsoft
windows support the output of information to a printer and the input of data through a modem, scanner or
mouse.  This information exchange is usually handled or controlled by a special driver that typically manipulates
the data in some way.



Nortel Symposium Desktop TAPI Service Provider 1.5 Chapter 1  Overview  •  13
User’s Guide

TAPI applications rely on the Nortel Symposium Desktop TAPI Service Provider to manipulate the exchange of
information between the personal computer’s COMM 1, COMM 2, COMM 3, or COMM 4 port and a telephone
using an interface device, such as a Meridian Communications Adapter (MCA), Nortel Symposium
Communicator card, or a VISIT Interface Unit (VIU).

Call Presentation
TAPI compliant applications usually support the ability to place calls, answer calls, hold and un-hold calls,
transfer and conference calls, as well as other features.  However, one of the most important functions of the
TAPI Service Provider is to interpret the information that is presented to the telephone set and pass that
information on to the TAPI compliant application through an interface device.  This is called “Call
Presentation.”

Many TAPI compliant applications, such as Nortel Symposium FastCall and FastView, Nortel Symposium
Multimedia Conferencing, and Nortel Symposium Call Manager, use the information to perform a particular
function.  This function may include call routing or screen pops.  Refer to the Nortel Symposium Desktop TAPI
Service Provider Implementation Planning Guide for the various kinds of information that the Meridian 1
option 11-81 PBX or MSL-100/DMS-100 telephone systems can deliver to a telephone set.  In addition, we
recommend that you check with your telephone system administrator to determine which functions are available
at your location.

Nortel’s TAPI SP 1.5 and Other Software Products
Nortel’s TAPI SP 1.5 works with many other software products, such as Nortel Symposium FastCall and
FastView, Nortel Symposium Multimedia Conferencing, and Nortel Symposium Call Manager.  Refer to the
user documentation provided with these products for detailed information.

In addition, Microsoft Outlook 97 Version 8.02.4212 or above works with Nortel’s TAPI SP 1.5.  Additional
information for configuring Microsoft Outlook 97 is provided in the “Microsoft Outlook 97” section located in
Chapter 4.
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Chapter 2  Installing Nortel’s TAPI SP 1.5

This chapter provides instructions and information for installing Nortel’s TAPI SP 1.5 and includes the System
requirements and hardware configurations.

System Requirements for Installing Nortel’s TAPI SP 1.5
Before you install and configure Nortel’s TAPI SP 1.5, you should become familiar with the system hardware
and software requirements, hardware configuration and connectivity as described in this section.

Installation of the Nortel’s TAPI SP 1.5 requires the hardware and software listed in the following sections.
Install the required hardware and software before installing the service provider software.

Note:  Lower system speeds and lower memory capacities may adversely affect system performance.

Be sure to read the latest release notes and README.TXT files that came in your package before attempting to
install any software.

Minimum Hardware Requirements
The minimum hardware requirements for the Nortel’s TAPI SP 1.5 include:

• 386/33 MHz

• 3.5” disk drive

• 8 MB of RAM is recommended.  Also check the application requirements.
Memory - the amount of memory needed by Nortel’s TAPI SP 1.5 to run depends on the interface
device being used, according to the following list:
-TelAdaptor 236 KB

-MCA 196 KB

-MPDA 196 KB
-VIU 175 KB
- Communicator Card 200 KB

Note:  These values increase as the number of DNs and features assigned to the set increases, but are
never more than 25%.

• The amount of free disk space that is needed for Nortel’s TAPI SP 1.5 depends upon the installation
options you select:  3925 Kilobytes of free space is required for the complete installation of TAPI SP
1.5 software, Diagnostic Tools, and online documents; 1875 Kilobytes of free disk space is required for
installing the TAPI SP 1.5 software and Diagnostic Tools; and 1757 Kilobytes is required for installing
the TAPI SP 1.5 software.  Additional free disk space is required for running TAPI applications.  Refer
to the appropriate TAPI application document for information regarding additional disk space needed
for the application

• Mouse (optional, but strongly recommended for installation)

• COMM 1, COMM 2, COMM 3, or COMM 4 available

• VGA or SVGA display
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Minimum Software Requirements

The minimum software requirements for Nortel’s TAPI SP 1.5 include:

• MS-DOS 5.0 or later

• Microsoft Windows 3.1 or later, Windows for Workgroups, or Windows 95 (Windows NT is not
supported with this release)

Interface Devices

• Meridian TelAdaptor TCM (NT5P41TA), Meridian Communications Adapter (MCA - NT2K65XJ), or
Meridian Programmable Data Adapter (MPDA) for use on M1 options 11-81 with all cables and power
supply (refer to the product’s installation guide)

• VISIT Interface Unit (VIU for use on MSL-100 or DMS-100 switches with all cables and power
supply), refer to the product’s installation guide - NTFX12AA

• Nortel Symposium Communicator card, refer to the documentation provided with the Nortel
Symposium Communicator card for detailed information

Cables
• NT5P41AP PC Serial/Modem or VISIT Interface Unit (DB-9/DB-25)

or
• NT5P41AQ PC Serial Modem (DB-25/DB-25)

or
• PC Serial DB9 Mini-din 8 CT/D

Configuring the PBX and Switch Equipment
The following sections provide the configuration information needed to install Nortel’s TAPI SP 1.5 on the M1
Option 11-81 PBX and on the MSL-100/DMS-100 switch.

Configuring the Meridian 1/SL-1 PBX

This section describes and illustrates the components needed for the installation of  Nortel’s TAPI SP 1.5 on M1
Option 11-81 PBXs.  Included are the necessary software releases, line cards, telephones, and interface devices
supported.  Required cabling is also listed.  A sample M1 Option 11-81 telephone set configuration is provided.

Software Releases
The software release required:

• for Meridian SL-1 -- X11 Release 14 or greater

• for Meridian 1 Option 11 --  X11 Release 16 or greater

• for Meridian 1 Option 21-81  -- X11 Release 15 or greater
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Line Cards
One of the following line cards is required.

• NT8D02AB and above Digital line card in an IPE module

• QPC578 Digital line card in a PE module

Telephones Supported
The following Meridian Modular Telephones are supported.

• M2006

• M2008

• M2216ACD-1

• M2216ACD-2

• M2616

The following Orion Telephones are supported.

• M3110

• M3310

• M3820

Interface Devices Supported
The following interface device is supported:

• Meridian TelAdaptor TCM

Note: This device may not work properly with the RS232 ports on some microchannel-bus PC's such as
the IBM PS/2, and other PC's such as the IBM Thinkpad.  The Meridian Communications Adapter is
the recommended device for microchannel-bus PC's.

• Meridian Communications Adapter (MCA)

• Meridian Programmable Data Adapter (MPDA)

Note:  The MPDA is a discontinued connectivity device, MCA is the current replacement.  If you have
problems using the MPDA, upgrade to the MCA.

• Nortel Symposium Communicator Card

Cables Required for Interfaces
The cables required for the interfaces include:

• Cables for MCA and MPDA:

- Cable: PC serial/modem (DB-25/DB-25) Part # NT5P41AQ
- Cable: PC serial/modem (DB-9/DB-25) Part # NT5P41AP

• Cables for TelAdaptor TCM:

- Cable: PC serial/TelAdaptor (DB-25/Mini-DIN-8) Part # NT5P41AN
- Cable: PC serial/TelAdaptor (DB-9/Mini-DIN-8) Part # NT5P41AM

• Cables for Nortel Symposium Communicator card:

- Cable:  RJ11 Line cord Part # A0274382
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Figure 3 shows the TAPI SP components on Meridian 1 Option 11-81.

Figure 3  TAPI SP components on Meridian 1 Option 11-81

Sample M1 Option 11-81 Telephone Set Configuration
Table 1 lists telephone set configuration information required for Meridian 1 Option 11-81 PBXs.  Use this
sample configuration when adding a new M2006, M2008, M2216 ACD or M2616 Meridian Modular Telephone
(MMT) or a M3110, M3310, M3820 Orion set.
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Table 1  Sample M1 Option 11-81 telephone set configuration

LD 11

REQ NEW

TYPE 2006, 2008, 2216 or 2616

TN L S C U (Terminal number for set)

DES Designation

AOM <cr>

<cr>

.

.

RNPG 1 (Call Pickup Group #)

CLS CNDA, DNDA, ADD, PUA, MWA (Call Pickup Allowed)

<cr>

.

.

KEY 0 SCR Voice DN (for dialing out and receiving calls)

KEY xx SCR Optional Voice DN

KEY xx DSP (must be configured to support delivery to TAPI application
of Calling/Called number on incoming calls to DNs on Keys
1 or higher before answering the call)

KEY xx TRN (Call Transfer)

KEY xx AO3 or AO6 (AO3 supports 3 party conference; AO6 supports 6 party
conference)

KEY xx PRK (Call Park)

KEY xx RNP (Call Pickup, Directed Call Pickup)

KEY xx RGA (Ring Again)

KEY xx CFW 4 (Call Forward)

If the telephone set is an ACD Agent set, configure the set as indicated in Table 1 with the exceptions and
additions listed in Table 2.

Table 2  ACD Agent set exceptions to Table 1

CLS CNDA, DNDA, ADD, AGN

KEY xx ACD xxxx yyyy

where:

xx = key number (must be key 0) (In- Calls Key)

xxxx = ACD DN

yyyy = Agent's position ID

KEY xx SCR DN (For dialing out and receiving calls)

KEY xx NRD (Not Ready Key)

KEY xx MSB (Make Set Busy)

KEY xx ACNT  Activity Code

KEY xx DWC yyyy Displaying Calls
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The following instructions apply to the configuration in Table 2.

1. Use LD 95 to assign a name to the DNs on this set.  The names will be presented to the TAPI
application if allowed.

2. Use LD 23 to configure ACD Queues and enable Call Forcing for ACD sets (Refer to Meridian 1 ACD
documentation for details).

3. Make sure the Meridian 1 PBX is equipped to deliver ANI/CLID and/or DNIS to the telephone set to
support Screen Popping on ANI/CLID or DNIS.

4. TAPI applications cannot dial out on an In-Calls key.

Refer to ACD Feature Description NTP 553-2671-110 or X11 features and services NTP 553-3001-305 for
additional information about Dialed Number Identification Service (DNIS).

Configuring the MSL-100/DMS-100

This section describes and illustrates the components needed for the installation of TAPI SP on MSL-100/DMS-
100 switches.  Included are the necessary software releases, line cards, telephones, and interface devices
supported.  Required cabling is listed.  A sample MSL-100/DMS-100 telephone set configuration is provided.

Software Release
The software release required for MSL-100/DMS-100 is BCS34 or higher.

Line Cards
The line card required is an NT8DO2EA IPE card or an NT6X21 Meridian Business Set (MBS) Line Card in an
LCM/LCMI or LCME Frame.

Telephones Supported
The following Meridian Modular Sets (MMT) are supported on IPE with MCA:

• M2008

• M2216

• M2616

The following Meridian Business Sets (MBS) are supported with VIU:

• M5009

• M5209

• M5112

• M5212

• M5312

Interface Device Supported
The VISIT Interface Unit (VIU) interface device is supported.
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Cables Required for Interface
• The following cables are required for the VIU interface:

- Cable: PC/serial/modem (DB25/DB-25) Part # NT5P41AQ

- Cable: PC/serial/modem (DB-9/DB-25) Part # NT5P41AP

• Cables for MCA interface device:

- Cable: PC serial/modem (DB-25/DB-25) Part # NT5P41AQ
- Cable: PC serial/modem (DB-9/DB-25) Part # NT5P41AP

Figure 4 shows the necessary software releases and line cards required for the MSL-100 and DMS-100 switch.
Refer to the VISIT Technical Reference Guide for more information on MSL-100/DMS-100 configuration.

Figure 4  Nortel’s TAPI SP 1.5 components on MSL-100/DMS-100
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Sample MSL-100/DMS-100 Telephone Set Configuration
Table 3 shows a sample configuration printout of an M5209, M5009, M5112, or M5312 Meridian Business Set
(MBS) added to a MSL-100/DMS-100 using Servord.

Table 3  Sample Configuration of MSL-100/DMS-100 telephone set configuration

>qlen 0 0 6 22

LEN:  HOST 00 0 06 22

TYPE:  SINGLE PARTY LINE

SNPA:  214

DIRECTORY NUMBER: 2446003

LINE CLASS CODE:  M5312 SET

CUSTGRP:  COMMON SUBGRP:  0  NCOS:  0  RING:  Y

CARDCODE:  6X21AC GND: N  PADGRP: NPDGP  BNV: NL  MNO: Y

PM NODE NUMBER:  17

PM TERMINAL NUMBER:  215

DNGRPS OPTIONS:

NETNAME:  PRIVPBX

ADDRESS:  DDDNNNNNNN

OPTIONS:

3WC LNR NAME PRIVPBX BOB (Transfer and/or 3 party conference)

CFU N 2446001 I 1 INSPECT CNF C06 (CFU=Call Forward Universal; C06=six party
conference)

KEY DN

1 DN     2446003

2 DN     2446004

3 DN     2446005

KEY FEATURE

4 3WC (Transfer/3 party conference)

5 CFU N  2446001 I 1 (Call Forward Universal)

6 INSPECT

8 CNF C06 (6 party conference)

The following requirements apply to the configuration shown in Table 3.

1. The Line Class Code must match the supported telephone types on MSL-100 and DMS-100 (see earlier
section).  If the Line Class Code is M5009, the DISP option must be assigned to Key 0 to make the
display operational.

2. Option 3WC must be assigned to support transfer and 3 party conference.

3. An INSPECT key must be assigned if you want TAPI SP to deliver to the TAPI application the Calling
number or Called number to lines 2 and above before the call is answered (for example, screen pop
before answer).

4. A CNF CO6 conference key must be assigned to the set to support 6 party conference.

5. Feature Package NTXE40AB must be present on the MSL-100/DMS-100.  This package provides the
capability for incoming call information, such as Calling Name and Calling number, to be automatically
displayed on the Meridian Business Set before the call is answered.

Feature package NTXE40AB consists of two Feature numbers as follows:
- AG1549 Auto Display for Meridian Business Sets (AUTODISP must not be assigned).
- AG1403 Business Set Inspect Key (an Inspect Key must be assigned as indicated in Step 3 above).



Nortel Symposium Desktop TAPI Service Provider 1.5 Chapter 2  Installing Nortel’s TAPI SP 1.5  •  23
User’s Guide

Sample M5212 ACD MBS added to MSL-100/DMS-100
Table 4 shows a sample configuration printout of an M5212 ACD Meridian Business Set (MBS)  added to a
MSL-100/DMS-100 using Servord.

Table 4  Sample Configuration of M512 ACD MBS added to MSL-100/DMS-100

>qlen 0 0 6 26

LEN:  HOST 00 0 06 26

TYPE:  SINGLE PARTY LINE

SNPA:  214

DIRECTORY NUMBER: 2446010 (NON-UNIQUE)

LINE CLASS CODE:  M5212 SET

CUSTGRP:  COMMON SUBGRP:  0  NCOS:  0  RING:  Y

ACDKEY:  INCALLS  ACDY  1  FORCING  Y  1113

CARDCODE:  6X21AC   GND:  N  PADGRP:  NPDGP  BNV:  NL  MNO:  Y

PM NODE NUMBER:  17

PM TERMINAL NUMBER:  219

DNGRPS OPTIONS:

NETNAME:  PRIVPBX

ADDRESS:  DDDNNNNNNN

OPTIONS:

MSB

3WC ACDNR

CNF C06 INSPECT

KEY DN

1 ACD   2446010  INCALLS  ACDY  1 FORCING  Y  1113

2 DN      2446011

11 DN       2446014

KEY FEATURE

3 ACDNR (Not Ready)

4 MSB $ (Make Set Busy)

5 CNF C06 (6 party conference)

6 3WC (Transfer/3 party conference)

7 CPU  0 HOST  00 0 06 26 2 (Call Pickup)

8 INSPECT

10 CFU N  2446013 I 2 (Call Forward Universal)

The following requirements apply to the configuration shown in Table 4.

1. The Line Class Code above must match the ACD telephone type defined during Nortel’s TAPI SP 1.5
setup procedure (see the "Nortel’s TAPI SP 1.5 Software Installation" section in this chapter).
Normally, M5212 sets are used as ACD sets.  If the Line Class Code is M5009, the DISP option must
be assigned to Key 0 to make the display operational.

2. The DMS-100 telephone System must be equipped with the Automatic Call Distribution Feature
Package NTX407AB.  ACD Groups and agents must be configured and operational with an ACD In-
Calls key assigned to Key 0 of the Meridian Business Set.  TAPI applications cannot dial out on an In-
calls key.

3. Option 3WC must be assigned to support Transfer and 3 party conference.

4. An INSPECT key must be assigned if you want TAPI SP to deliver to the TAPI application the Calling
number or Called number to lines 2 and above before the call is answered (for example, screen pop
before answer).
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5. Feature Package NTXE40AB must be present on the MSL-100/DMS-100.  This package provides the
capability for incoming call information, such as Calling Name and number, to be automatically
displayed on the Meridian Business Set before the call is answered.

Feature package NTXE40AB consists of two Feature numbers as follows:

- AG1549 - Auto Display for Meridian Business Sets (AUTODISP
       must  not be assigned).

- AG1403 - Business Set Inspect Key (an Inspect Key is highly
        recommended).

6. A CNF CO6 conference key must be assigned to the set to support 6 party conference.

7. An In-Calls key must be assigned to Key 0 for ACD sets and the DMS-100 telephone system must be
equipped with the In-Calls Key (Feature number F3923).  When Configuring Nortel’s TAPI SP 1.5
(Telephone Setup), you must define an In-Calls key on Key 0 of all ACD sets.

8. If Call Forcing is assigned to the In-Calls Key 0, Call Forcing must also be enabled in TAPI SP
(Telephone Setup area for Key 0; refer to the "Configuring the Telephone" section located in Chapter
3).

9. A NOT READY key (ACDNR) is normally assigned to the ACD set using the TAPI application.

10. A Make Set Busy (MSB) key is normally assigned to the ACD set using the TAPI application.

11. A Secondary DN key must be assigned to the ACD set to support the placing of calls using the TAPI
application.

12. To allow the TAPI application to screen pop on the Called/Dialed number (sometimes called DNIS),
the MSL-100/DMS-100 must be equipped with the Called Name/Called number Display feature and
table ACDGRP must be datafilled with the Option ACDDISP.  Have your MSL-100/DMS-100 switch
administrator refer to Automatic Call Distribution Translations Guide NTP 297-2041-350 for details.
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Sample of an ACD 2616 Set on MSL-100
Table 5 shows a sample configuration printout of an ACD 2616 set on MSL-100.  This information is retrieved
by way of the qlen command followed by the LEN (Line Equipment Number).

All setups for lines in MSL-100 or DMS-100 are done through the Servord utility.

Table 5  Sample configuration of ACD 2616 set on MSL-100

LEN:           02 0 02 02
TYPE: SINGLE PARTY LINE
SNPA: 612
DIRECTORY NUMBER:     9329001
LINE CLASS CODE:  M2616 WITH DISPLAY AND HANDSFREE
CUSTGRP:          NORTEL  SUBGRP: 0  NCOS: 0  RING: Y
ACDKEY: INCALLS     CTI     1     N
CARDCODE:  8D02AB    GND: N  PADGRP: NPDGP  BNV: NL MNO: Y
PM NODE NUMBER     :    24
PM TERMINAL NUMBER :    67
DNGRPS OPTIONS:
NETNAME:PUBLIC
NONUNIQUE
OPTIONS:
MSB
3WC RAG ACDNR
EMK Y CTI 1 LOB CNF C06 CLI INSPECT

   KEY       DN
   ---       --
      1      ACD            9329001    INCALLS    CTI    1    N
      2      DN             9321190
      9      ACD            9321192    CLSUP    CTI    1    MSBOVRD

   KEY     FEATURE
   ---     -------
     1        CLI
     2        CLI
     3        MSB $
     4      ACDNR
     5        CNF C06
     6        3WC
     8        PROGRAM KEY
     9        CLI
    11    INSPECT
    12        RAG
    13        LOB
    14        EMK Y CTI   1
    15        DQT N
    16        HANDSFREE
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Nortel’s TAPI SP 1.5 Software Installation
This section describes the procedures that must be performed to successfully install Nortel’s TAPI SP Release
1.5.  Prior to installing this software, you must have certain hardware, software, and telecommunication
configurations in place.  These pre-installation configurations are detailed in the following checklist.

Pre-installation Checklist

Before installing the software, complete the following pre-installation checklist.

1.  Verify that VISIT Voice 2.0 and VISIT Video 2.0 are not installed on the PC.  Installing TAPI SP will
cause these applications to stop working until an upgrade to Nortel Symposium Call Manager 4.0 (or
above) or Nortel Symposium Multimedia Conferencing 4.0 (or above) is installed.

2.  Uninstall any previous version of Nortel's TAPI Service Provider.   It is important to remove the
previous version of TAPI software before upgrading to the new software.  To remove the previous
version, run the Uninstall program.

3. Verify that your PC meets the minimum hardware and software requirements defined in the "System
Requirements for Installing Nortel’s TAPI SP 1.5" section in this chapter.

Note:  Nortel’s TAPI SP 1.5 is not supported on Microchannel (PS/2) personal computers using
TelAdaptors as the interface device.  However, Nortel’s TAPI SP 1.5 does support Microchannel PCs
using Meridian Communications Adapters (MCA), Meridian Programmable Data Adapters (MPDA),
or VISIT Interface Units (VIU).

4. Verify that your telephone type is one of the supported telephones listed in the "Nortel’s TAPI SP 1.5
System Requirements" section in this chapter.

If your telephone is an M2006, M2008, M2216 ACD set, M2616 set, or an M3110, M3310, M3820
Orion set,  the Meridian 1 Option 11-81 PBX Administrator must configure the telephone set so the set
will work with your TAPI application.

If the telephone is an M2006, M2008, M2216 ACD set, M2616 set , or an M5209, M5009, M5112,
M5212 ACD, M5312 set, the MSL-100/DMS-100 telephone system Service Order (Servord)
Administrator must configure the telephone set.

5. Verify that your MMT telephone or Meridian Business Set is operational and has at least one DN key
to support dialing and answering calls from the TAPI application.

Determine which telephone features your TAPI application will need to use, then verify that these
features are assigned to your set.  You can examine the feature keys on your telephone set or use the
sample telephone set configuration printouts in this chapter as a reference while working with your
telephone system administrator to verify that your phone is set up properly to support your TAPI
application.

6. Verify that the telephone system to which your phone is connected is one of the Meridian 1/MSL-1
PBX or MSL-100/DMS-100 configurations listed in the "Nortel’s TAPI SP 1.5 System Requirements"
section in this chapter.

7. In Table 6, 7, and 8, circle the device type, telephone type, and the COMM port on the PC you will be
using.

Table 6  Device type

Interface Device: TelAdaptor MCA MPDA Communicator VIU
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Table 7  Phone Type

Telephone Type TelAdaptor MCA MPDA Communicator VIU

Meridian
Modular
(MMT)

M2006
M2008 M2216
M2616

2000 Series
M2009
M2018
M2112
M2317

Meridian
Modular
(MMT)

M2006
M2008 M2216
M2616

Orion
M3110
M3310
M3820

Meridian
Modular
(MMT)

M2006
M2008 M2216
M2616

Meridian Modular
(MMT)

M2006
M2008
M2216
M2616

Orion
M3110
M3310
M3820

Meridian
Business
(MBS)

M5009
M5112
M5212
M5312
M5209

Table 8  COMM port

PC COMM Port COMM 1 COMM 2 COMM 3 COMM 4

8. Fill in the three parts of Table 9 to record the directory numbers (DNs) that appear on your telephone
set, to record the ACD DN and Position ID for the In-Calls Key for ACD sets, and  to record whether
the ACD set will be using Call Forcing.  Record the add-on module DNs along with any names that you
want to associate with the DNs.

You may want to use names that your telephone system has already associated with the DNs.  These
descriptions will be used when you configure your telephone using the Telephony icon in the Control
Panel window.

Table 9  Directory Numbers (DNs) on your set

Key Telephone  DN Name

Key ADC DN Position ID Name Call Forcing

0 Yes   or   No

Key Add-On Module DN Name
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9. If your telephone is equipped with an MCA, verify the following:
- The red LED at the rear of the telephone set is flashing.
- The serial modem cable is installed between your PC COMM port (1, 2, 3, or 4) and the MCA

(refer to the "Installing the TAPI SP 1.5" section in this chapter).
- Enter the following Program key sequences from your set:

a. Enter 67, select Unlock and press the Program key.
b. Enter 65 and press the Program key.
c. Enter 22, enter 2400 for the baud rate and press the Program key.
d. Enter 20 and press the Program key.
e. Enter 34 and press the Program key
f. Enter 67, select Lock and press the Program key.

10. If your telephone is equipped with an MPDA, verify the following:
- The red LED at the rear of the telephone set is flashing.
- The serial modem cable is installed between your PC COMM port 1, 2, 3, or 4 and the MPDA

(refer to the "Installing the TAPI SP 1.5" section in this chapter).

Note:  The MPDA is a discontinued connectivity device, MCA is the current replacement.  If you
have problems using the MPDA, upgrade to the MCA.

11. If your telephone is connected through a Meridian TelAdaptor TCM, verify the following:

- The TelAdaptor is plugged in and the green LED on top of the TelAdaptor is lit.
- The serial modem cable is installed between your PC COMM port 1, 2, 3, or 4 and the TelAdaptor

(refer to the "Installing the TAPI SP 1.5" section in this chapter).

12. If your telephone is equipped with a VISIT Interface Unit (VIU), verify the following:

- The VIU is plugged in.
- The serial modem cable is installed between your PC COMM port 1, 2, 3, or 4 and the VIU.

13. If you are using Nortel Symposium Communicator card for an interface device, the card must be
installed and configured before loading Nortel’s TAPI SP 1.5.   For detailed instructions on installing
and configuring refer to the documentation provided with Nortel Symposium Communicator card.

Cautions and Preparations

The installation process includes only the installation of Nortel’s TAPI SP 1.5.  Nortel’s TAPI SP 1.5 must be
installed first and your phone configured before installing any TAPI applications, as described in the following
procedures.

Exceptions to this rule is the Nortel Symposium Call Manager and the Nortel Symposium Multimedia
Conferencing 4.0/5.0 installer provides the option to install Nortel’s TAPI SP 1.5 at the end of its installation
process.  Refer to the installation instructions in the product documentation for details.

Note:  If you are installing Nortel’s TAPI SP 1.5 on a PC that has VISIT Voice 2.0, VISIT Video 2.0, or VISIT
FastCall 1.0 installed, these applications will no longer work until you upgrade to Nortel Symposium Call
Manager 4.0 (or above), Nortel Symposium Multimedia Conferencing 4.0 (or above), or VISIT FastCall 1.1.
Refer to the README.TXT file provided with the Nortel’s TAPI SP 1.5 software before continuing.

If you are using Windows 95 and have Microsoft TAPI 2.1, you will have to uninstall the Microsoft TAPI 2.1
and reinstall Microsoft TAPI 1.4.  Instructions for this procedure are provided in the “Removing Microsoft
TAPI 2.1 Software” section in Chapter 4.
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Installing Nortel’s TAPI SP 1.5 Software

The Nortel Symposium Desktop TAPI SP 1.5 is available from the Web or when purchasing other applications.
Depending upon the application, Nortel’s TAPI SP 1.5 may be included on a diskette or on a CD ROM.  If
applicable, refer to the user documentation provided with your application for special instructions on loading
TAPI software in conjunction with the application.

The online documents and the Troubleshooting help file are provided on the Web site and may also be contained
in the Docs folder on the application’s  CD ROM.  If you install from a CD ROM, certain applications  may
automatically install the User’s Guide online document and the Troubleshooting help file in the NTTAPISP
directory.  If the online document and Troubleshooting help file are installed, they are displayed in the
Symposium Desktop TAPI SP program (Windows 95) and in the Symposium Desktop TAPI SP program window
(Windows 3.1).

Note:  Installing Nortel's TAPI SP 1.5 from Nortel’s Web site or from a diskette does not install the online
documents or the Troubleshooting Help file.  You may access the online documents from Nortel’s Web site,
www.nortel.com/bap/sales.htm, and selecting the Symposium Desktop TAPI.

Prior to installing Nortel’s TAPI SP 1.5 software, ensure the Pre-installation checklist (located in the “Pre-
installation checklist” section in this chapter) is complete.

Note:  If you have a previous version of Nortel's TAPI Service Provider installed, run the Uninstall program for
your version before installing Nortel's TAPI SP 1.5 software.  If necessary, refer to the “Removing Nortel’s
TAPI SP 1.5 Software” section located in Chapter 4.

Instructions are provided on installing Nortel’s TAPI SP 1.5 from the Web site, from a diskette, and from
a CD ROM.  Once the installation process has started, instructions are the same for each installation.

Note:  Before starting the Nortel’s TAPI SP 1.5 software installation, close any TAPI applications that are
running.

To Install from the Web Site:
1. From the Web Site, www.nortel.com/bap/sales.htm,, select and download the Symposium Desktop

TAPI SP 1.5 version 1.5.0.XX.  The Symposium Desktop TAPI SP are downloaded in a self extracting
ZIP file.  (Make a note of the directory where the file is downloaded.)

2.  When the file has finished downloading, go to the directory where the file was downloaded and double-
click on the TAP150XX.exe file.  The files are unzipped.

3.  Double-click on the Setup.exe file.
The installation process begins.  Refer to the “Completing the Installation” section.

Note:  If you are reading this document from the Web Site, you may wish to download it before starting
the installation.  You will need the Adobe Acrobat Reader installed on your machine to view and to
print the document.

To Install from the Diskette or the CD ROM:
1. Insert Nortel’s TAPI SP 1.5 installation diskette in the floppy disk drive or insert the CD ROM

containing Nortel’s TAPI SP 1.5 installation software in the CD ROM drive.

2. Follow the instructions below for installation on Windows 3.1 or Windows 95:
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If you are installing on Windows 3.1:

a. Select File from the Program Manager Menu bar
The File menu displays.

b. Click on Run
The Run dialog box displays.

c. Type the path for the floppy disk drive or CD ROM  followed by \setup.exe in the Run dialog
box.
For example:
A:setup.exe
E:\Servprov\NTTSP\disk 1\setup.exe

d. Click on the OK  button.

If You are installing on Windows 95:

a. Click on the Start button and Select Run.
The Run dialog box is displayed.

b. Type the path for the diskette or CD ROM followed by \setup.exe in the Run dialog box.
For example:
A:setup.exe
E:\Servprov\NTTSP\disk1\setup.exe

c. Click on the OK  button.

The installation process begins.  Refer to the “Completing the Installation” section.

Completing the Installation
To Complete the Installation when the Setup dialog box is displayed:

1. Click on the Next button to continue the installation.
The Select Installation: dialog box is displayed.
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Note:  We recommend that you read the README.TXT file before installing the software.
However, this file is available after installation by selecting Readme on the Symposium Desktop
TAPI SP program group (Windows 95) or by double-clicking on the Readme icon located on the
Symposium Desktop TAPI SP program group window (Windows 3.x).

2. Click on the Install  button followed by the Next button.
The Select Components dialog box displays the available components and the default installation
directory.

Note:  Certain installations from the CD ROM may provide the option to install the online
documentation.
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3. To clear a component, click on the check box located to the left of the component.  A check box with a
check mark means the component will be installed.

4. Check the disk space to ensure you have enough disk space to install Nortel's TAPI SP 1.5.

5. Click on the Next > button to accept the default directory and continue the installation.
Or
Enter or select (with the Browse… button) a new path name and click Next >.  The drive in the path
name must have Windows 3.1, Windows for Workgroups, or Windows 95 installed.

The Setup dialog box displays the files that are being installed.

a. If you have a previous version of Nortel’s TAPI Service Provider installed, the install program
asks if you wish to continue the installation.

Click on the Yes button to continue the installation.
Or
Click on the No button to cancel the installation.

b. If you have a previous TAPI configuration, the following dialog box displays the information.
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Click on the desired Yes or No button to continue the installation.

Nortel’s TAPI Service Provider Installer creates a Program Group called Symposium Desktop
TAPI SP.

Note:  If your PC does not have Microsoft TAPI installed, Nortel’s TAPI SP 1.5 will install a new
version of TAPI (Version 1.3).

When the installation is complete, you are notified with the following dialog box.

8. If applicable, remove the CD ROM or diskette from the drive and click on the OK button.

9. Configure Nortel’s TAPI SP 1.5.  Refer to Chapter 3 for detailed information.

The Symposium Desktop TAPI SP program group contains four icons labeled:
- Nortel TAPI Initializer
- Readme (text file)
- TAPI Test Program
- TAPI Logger

In addition, certain installations from the CD ROM may provide online documentation.  The additional
icons for the available documentation are displayed in the program group (Windows 95),
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and the program group window (Windows 3.1).

If you copy or drag the Nortel TAPI Initializer  icon to the Startup Program Group, TAPI is initialized when
Windows is started.  As a result, TAPI applications will start up quicker.  It is recommended that this icon be
copied to the Startup group only after the TAPI Service Provider has been configured and you have verified
that your selected TAPI Application starts up without error.

Refer to Chapter 3 for detailed instructions on configuring Nortel’s TAPI Service Provider 1.5.  Refer to
Chapter 4 for detailed information on using the TAPI Test Program and the TAPI Logger.
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Chapter 3  Configuring Nortel’s TAPI SP 1.5

 This chapter provides information on configuring the Nortel Symposium Desktop TAPI Service Provider 1.5.

Overview of the Configuration Process
Before installing TAPI applications, you must configure the Nortel Symposium Desktop TAPI Service Provider
1.5 (Nortel’s TAPI SP 1.5).  Nortel’s TAPI SP 1.5 enables TAPI compliant applications to communicate calling
information and other commands to and from applications.  The configuration process consists of accessing the
Nortel TAPI SP Setup dialog box and configuring the Interface device, the telephone, the SCCS and ACD
parameters, if applicable, and the PBX/Switch.   Certain configurations require you to restart Windows to enable
the changes.

Note:  The dialog boxes shown in this section are examples of Windows 95 dialog boxes.  If you have Windows
3.1, the dialog boxes you see will vary.  However, the information on Windows 95 and Windows 3.1 dialog
boxes are the same.

Steps for Configuring Nortel’s TAPI SP 1.5
Configuration options are selected from the Nortel TAPI SP Setup dialog box.

Configuring Nortel’s TAPI Service Provider consists of the following steps:

1. Accessing the Nortel TAPI SP Setup dialog box and adding the driver.

2. Configuring the Interface device.

3. Configuring the telephone.
a. Configuring the SCCS parameters, if applicable.
b. Configuring the ACD parameters, if applicable.

4. Configuring the PBX/Switch (reason code parameters)

5. Closing the Nortel TAPI SP Setup dialog box.

The following sections provide instructions for each step.

Accessing the Nortel TAPI SP Setup Dialog Box
To Access the Nortel TAPI SP Dialog Box:

1. After installing Nortel’s TAPI SP 1.5 software and restarting Windows, if necessary, do one of the
following:

In Windows 3.1, click on the Main  program group in the Program Manager.
Or
In Windows 95, click on the Start button and select Settings.
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2.  Double-click on the Control Panel icon.

The Control Panel window displays the Telephony icon .

Note:  If the Telephony icon does not display (in Windows 95) after installing Nortel’s TAPI
SP 1.5 software, you must install the Windows Telephony Dialer software.  This is found on
your Windows 95 CD ROM.

3. Double-click on the Telephony icon.
In Windows 3.1, click on the Driver Setup.

A Telephony Properties dialog box displays a list of Installed Drivers on the left side.

If this is a first time to install a TAPI Service Provider, Nortel TAPI SP is not on the list.

Note:  The Nortel TAPI SP entry may appear on the list if the "telephone.ini" file in the Windows
directory has been previously modified by TAPI SP.

However, if "Nortel TAPI SP" does display, click on the Setup button and proceed to step 8 below.
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4. Click on the Add button.
The Add Driver dialog box displays the Telephony Drivers list containing the Nortel TAPI SP.

5. Click on Nortel TAPI SP to highlight it.

6. Click on the Add button.
The Nortel TAPI SP 1.5 Setup dialog box displays.

7. Configure the Interface Device, the Telephone, the PBX/Switch, the SCCS, and the ACD as applicable.

Configuring the Interface Device
To Configure the Interface Device from the Nortel TAPI SP 1.5 Setup dialog box:

1. Click on the Interface Device button.
The Device Setup dialog box displays.

2. Select your Voice Device and the port on your PC that is connected to the Voice Device.

Note:  Read the following information before selecting your Voice Device:

• If you select Nortel Symposium Communicator card, there is no need to select a port.
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• Only the Meridian TelAdaptor TCM, Meridian Communications Adapter (MCA), Meridian
Programmable Data Adapter (MPDA), or Nortel Symposium Communicator card are supported on
Meridian 1 Option 11-81 PBXs.  The VISIT Interface Unit, MCA and Nortel Symposium
Communicator card are the only options supported on MSL-100/DMS-100 telephone systems.

• If you choose TCM TelAdaptor as your interface device, Windows must be restarted when you
finish configuring Nortel’s TAPI SP 1.5.

• If you select MCA as your interface device and your MCA is connected to an MSL-100/DMS-100,
click on the Configure button and select SL1 as the switch type.  However, if your MCA is
connected to a Meridian 1 Option 11-81, you do not need to change any settings.

3. Click on the OK   button to save these settings.  If this is a re-installation or an upgrade, you still must
choose OK  if the interface device is already selected.  Selecting OK  downloads the correct drivers for
that device.

Configuring the Telephone
To Configure the Telephone from the Nortel TAPI SP 1.5 Setup dialog box:

1. Click on the Telephone button.
The Telephone Parameters dialog box is displayed.

2.  Click on the down arrow located to the right of the Phone listbox and click on appropriate telephone set
to select it.  It is important to select the phone type before configuring  any other phone parameter.
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Note:  Many different types of telephones may display in the Phone listbox, but only those listed in the
“System Requirements” section in Chapter 2 are currently supported by Nortel’s TAPI SP 1.5.

3. Define all of your telephone keys starting with the lower right.

Note:  The lower right key is for DN, Incalls, or Private only.  The other features apply to the other
keys.

a. Click on the Feature key (labeled “Other”)  The key number is displayed over the Features drop-
down listbox.

b. Click on the down arrow located to the right of the Feature listbox.
If you clicked on the lower right key (Key 0), the only features available are DN, Incalls, or
Private.
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c.  Choose the feature from the list that matches the key label on your phone and that has been
assigned by your telephone system administrator.

 The Information dialog box that is displayed, for adding additional information, depends upon the
option you selected.   

 For example, selecting Key 0 and the DN option, as shown below,

 
  displays the DN Information dialog box.

Or

 Selecting Key 0 and the InCalls feature, as shown,

 
 displays the In Calls Information dialog box.  This dialog box is used to configure ACD or SCCS

parameters.
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 Or

 Selecting a key other than Key 0 and the Park option displays the Park Information dialog box:

 
Each feature displays the information dialog box associated with the feature.

d.  Enter the requested information.

e.  Click on the OK  button to save the changes.

Note:  Read the following information before selecting the Features:

• If you plan to configure Symposium Call Center Server (SCCS), you must assign an In-Calls key
to the lower right key (Key 0).  Refer to the “Assigning the In-Calls Key” section for additional
information.

• If you are using an ACD set, you must assign an In-Calls key to the lower right key.  Refer to the
“Assigning the In-Calls Key” section for additional information.
In addition, enter your ACD Position ID and if Call Forcing is enabled on your set, you must also
check the Call Forcing check box when defining the In-Calls key on the In Calls Information
dialog box.  If your set automatically answers calls presented to the In-Calls key without you
having to press the key manually, Call Forcing has been enabled for your set.  This feature is often
used by ACD agents with headsets.

• If you selected an M2006, M2008, M2216, M2616 set (for Meridian 1), or an Orion set in Step 2,
you only need to define the DN, In-Calls and Call Park keys—including the Park retrieve Code
whose default (172) consists of a SPRE Code + the Call Park Retrieve feature Code (72).  The
remaining keys will be defined automatically when you exit the Control Panel and start the TAPI
application.  However, if you selected an M2317, M5009, M5209, M5112, M5212 or M5312 set
in Step 2, you must define all keys.  If a function is assigned to a key on the phone set it must be
configured here.  If there is not a function assigned to a key, it must be configured with the Other
function.

• If your telephone is equipped with an Add-On module, click on the Down arrow beside the Add on
1 field, and select Key Exp. module.  A  snapshot of the module should appear, and you can
configure the keys on the  module by highlighting the key and selecting a feature  from the
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"Features" drop down list.  TAPI SP 1.5 supports only Directory Numbers (DNs) on key
expansion modules.  You can configure up to 2 Add-on modules per set.

• Click on the Auto Inspect check box to allow the phone system to automatically depress the
display key on incoming calls.  If the check box is not checked, you will have to depress the
display key on incoming calls to view the incoming information.

• If your M2006, M2008, M2216 or M2616  (for Meridian 1) set , or your Orion set will be
receiving and displaying Dialed Number Identification  Service (DNIS) digits from the telephone
company, you  must check the DNIS check box that appears in the lower  right corner of the dialog
box; beside the keys of  all Meridian 1 sets.

• If your M2006, M2008, M2216 or M2616  (for Meridian 1) or your Orion set's Class of Service
has the “Reverse Lamp Flash Allowed” (RLFA) feature enabled, you must check the Reverse
Lamp Flash check box that appears in the  lower right corner of the dialog box; beside the keys of
all Meridian 1 sets.

• If your M2006, M2008, M2216 or M2616  (for Meridian 1) set or your Orion set  has either a key
configured on the set as AAK, or it's Class of Service has the "Automatic Answer Back Allowed"
(AAA)  feature enabled, you have to check the Automatic  Answerback check box that appears in
the lower right  corner of the dialog box; beside the keys of all  Meridian 1 sets.

4. After making the change, click on the OK  button to save the Telephone Parameters.
The Nortel TAPI SP 1.5 Setup dialog box displays.

Assigning the In-Calls Key

If you plan to configure SCCS or ACD and Agent Queues, you must assign Key 0 as an In-Calls Key.  After
selecting the In-Calls feature to Key 0, the In Calls Information dialog box is displayed.  This dialog box
provides three Agent ID Mode options.

To Assign an In-Calls key:

1. Click on the lower right key.

2. Click on the arrow next to the Feature listbox.

3. Select the In-Calls option.

The In Calls Information dialog box is displayed.
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4. Enter information as necessary.

5. Select the Agent ID Mode.

None - Select this option if you log in without having to enter Agent ID.

ACD - Select this option if you log in using Agent ID or if Multiple Queue assignment is configured
on the Meridian 1 switch for your set.

SCCS - Select this option if Symposium Call Center Server is controlling calls to your set’s In-call
key.

Selecting ACD or SCCS radio button displays additional dialog boxes.  Refer to the “Configuring the
ACD Parameters” or the “Configuring the SCCS Parameters” for additional information.

Or

If you selected the None option, click on the OK  button to save the changes.

Key 0, the lower right key, now displays In-Calls.

Configuring the ACD Parameters

The ACD Parameters dialog box allows the user to provide information to the TAPI application regarding some
ACD switch parameters.
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If capable, the TAPI application can reference this information on the ACD queues upper and lower Agent ID's,
which would allow the application to restrict certain login attempts.

Also, it can provide the application knowledge whether or not this specific user is an ACD Supervisor or has
specific priorities assigned to them through the switch.

Note:  The "ACD" is configurable only if the Switch is Meridian 1 or SL1 and an In-calls key has been assigned
in the Telephony Parameters dialog box. Refer to the "Assigning the In-Calls Key" section for detailed
information.

To Configure the ACD from the In-Calls Information dialog box:

1. Click on the ACD radio button .
Or
If you did not assign an Incalls key when configuring the telephone, do it now.

a. From the Telephone Parameters dialog box, click on the lower right key (Key 0).
b. Click on the arrow next to the Feature listbox.
c. Select the In-Calls option.

The In Calls Information dialog box is displayed.

d. Click on the ACD radio button to select it.

2. Click on the OK  button.
The ACD Parameters dialog box is displayed.
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3. Set the parameters, as applicable.

4. Click on the Multiple Queue Assignment check box, if applicable.  Clicking on this option displays the
following options.

5. Click on the OK  button to save the changes.

Configuring the Symposium Call Center Server (SCCS)

Before configuring the SCCS Call Presentation parser for an agent, the server must be set up with the SCCS Call
Presentation. When the setup is the same on both sides, the call presentation can be properly displayed.
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To Configure the SCCS from the In Calls Information dialog box:

1. Click on the SCCS radio button.
Or
If you did not assign an Incalls key when configuring the telephone, do it now.

a. From the Telephone Parameters dialog box, click on the lower right key (Key 0).on the lower right
key on the keypad.

b. Click on the arrow next to the Feature listbox.

c. Select the In-Calls option.

The In Calls Information dialog box is displayed.

d. Click on the SCCS radio button to select it and click on the OK  button.

The SCCS Call Presentation Setup dialog box is displayed.
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2. For each SCCS call presentation field:
set the row number (where the field will be displayed), the column number (where the field will be
started), and the length (which is the size of the field).

3. For the following DWC fields:
Wait, Manned, and Waiting Seconds
a default row number will be used.

The following information is displayed on an agent's phone set:
AAA-BBB-CCC
where:

AAA = number of calls currently waiting in all the active skillset queues defined for that agent
BBB = number of agent positions manned (logged in) for the active skillset queues that are

associated with the agent
CCC = the waiting time in seconds of the oldest all in the agent's active skill queues

DWC Key Set Display TYPE and Field Width

Display Type AAA BBB CCC
1 by 12 3 digits 3 digits 3 digits
1 by 16 4 digits 4 digits 4 digits
1 by 40 4 digits 4 digits 4 digits
2 by 24 4 digits 4 digits 4 digits
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When setting up the Symposium Call Center Server, (SCCS), you must decide what information you
would like to have displayed in the Called Party Field of the application you are working with. Each
selection in the Called Information field includes the Name and Number to be displayed.

After deciding what information is to be displayed by the server, you must have the correct fields
configured in the Call Presentation Setup to work properly.

4. Click on the OK  button to save the changes.

Configuring the PBX/Switch
The Reason codes that display when selecting the  PBX/Switch button depend upon your PBX/Switch type.
When configuring the PBX/Switch, check to be sure the Reason Code values are the same as the ones
configured on your switch.

Note:  Reason codes will appear on your telephone set's display embedded within quotation marks such as "B"
or "T."  These appear whenever calls are redirected within the telephone system such as hunting up your
keylamp strip on busy DNs or another telephone has been forwarded or transferred to your phone.  Pay
particular attention to whether there are blank spaces within the quotation marks.  If there are spaces, you may
need to include spaces when defining Reason Code Mnemonics under Telephone Setup.

Configuring the Meridian 1

To Configure the PBX/Switch button from the Nortel TAPI SP 1.5 Setup Dialog box:

1. Click on the PBX/Switch button.  If your switch is the Meridian 1, the following PBS/Switch
Parameters dialog box is displayed.
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2. Check to be sure that the Reason Code values are the same as the ones configured on your switch.  If
the mnemonics do not match the telephone systems configuration, your TAPI application may not
display the correct Calling/Called numbers when a Reason Code is displayed on the set.

Ask your Meridian 1 telephone system administrator to print the CPND data block in LD 95.  The
printout shows the information in Table 10.  The default PBX mnemonics are F, N, B, P, T.  If the
printout shows the mnemonics are different from those shown on the PBX/Switch Parameters dialog,
you must change the mnemonics to match the mnemonics set up on the Meridian 1 Telephone System.

Table 10  CPND data block information
REQ PRT

TYPE CPND

CUST 0

TYPE CPND

CUST 0

CNFG ALON

MXLN 27

STAL YES

DFLN 13

DES YES

RESN YES

CFWD F (Mnemonic for Call forward all calls display)

CFNA N (Mnemonic for Call forward No Answer display)

HUNT B (Mnemonic for Hunt/Call Forward Busy display)

PKUP P (Mnemonic for Call Pickup display)

XFER T (Mnemonic for Call Transfer display in Network Call
Redirection)

AAA A

For Example:

• If the CFWD mnemonic on the PBX is CFWD, you must change the Telephone Setup mnemonic
"Forward No Answer" to CFWD, then click OK .
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• If the HUNT mnemonic on the PBX is B and the telephone shows "B  " (B with two spaces after),
you must change the Telephone Setup mnemonic "Hunt/Forward Busy" to B followed by two
spaces, then click OK .

• The default XFER mnemonic on the PBX is T that shows up on the set as "T" indicating no spaces
need to be entered in the Reason Code mnemonic field.  Therefore, you would need to change the
Telephone Setup mnemonic "Transfer" to T followed by no spaces, then click OK .

3. Click on the OK  button to save changes to the PBX/Switch Parameters dialog box.
The Nortel TAPI SP Setup 1.5  dialog box displays.

Configuring the MSL-100/DMS-100

To Configure the PBX/Switch button from the Nortel TAPI SP 1.5 Setup Dialog box:

1. Click on the PBX/Switch button.  If your switch is the MSL-100/DMS-100, the following PBS/Switch
Parameters dialog box is displayed.

2. Check to be sure that the Reason Code values are the same as the ones configured on your switch.  If
the mnemonics do not match the telephone systems configuration, your TAPI application may not
display the correct Calling/Called numbers when a Reason Code is displayed on the set.

Ask your MSL-100/DMS-100 to print out Table "REASONS" to get a list of the reason code
mnemonics then change your default mnemonics to match the MSL-100/DMS-100 configuration as
necessary.

Table 11 provides an example of a partial print out of the Table “REASONS”  for the MSL-100.  The
ones that appear in the TAPI control panel are the important ones for you.

Note: The _ in each entry is actually a space on the display of the phone.  The message on the right is
what shows on the phone, for example,  "Call Transfer" when a call is transferred to the phone.
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Table 11  Table Reasons  printout

TABLE: REASONS
TOP
        REASNSET            REASONID           MESSAGE
------------------------------------------------------
      DEFAULTSET          UNKNOWNMSG      NO_CALL_INFO
      DEFAULTSET         EXTERNALMSG      OUTSIDE_CALL
      DEFAULTSET             CONFMSG        CONFERENCE
      DEFAULTSET          BARGEINMSG          BARGE_IN
      DEFAULTSET          TERMCFUMSG          CALL_FWD
      DEFAULTSET          TERMCFDMSG        NO_ANS_FWD
      DEFAULTSET          TERMCFBMSG          BUSY_FWD
      DEFAULTSET          ORIGFWDMSG           FORWARD
      DEFAULTSET          TERMCPUMSG            PICKUP
      DEFAULTSET             CPKRMSG       PARK_RECALL
      DEFAULTSET             CXRRMSG      TRANSFER_RCL
      DEFAULTSET          ORIGCPUMSG         PICKED_UP
      DEFAULTSET              CXRMSG     CALL_TRANSFER
      DEFAULTSET          INSPACTGRP      ACTIVE_GROUP
      DEFAULTSET             INSPAUD    AUTOMATIC_DIAL
      DEFAULTSET             INSPAUL    AUTOMATIC_LINE
      DEFAULTSET             INSPCFW      CALL_FORWARD
      DEFAULTSET         INSPCALLMWT   NN_MSGS_WAITING
      DEFAULTSET             INSPCPK         CALL_PARK
      DEFAULTSET             INSPCPU       CALL_PICKUP
      DEFAULTSET             INSPCWT     CALL_WAIT_KEY
      DEFAULTSET            INSPCNF6            CONF-6
    .

.

.
BOTTOM

3.  Click on the OK  button to save changes to the PBX/Switch Parameters dialog box.
The Nortel TAPI SP Setup 1.5  dialog box displays.

Closing the Nortel TAPI SP Setup Dialog Box
To Close the  Nortel TAPI SP Setup Dialog Box:

1. Click on the Close button to exit the Nortel TAPI SP Setup dialog box.

2. Click on the Close button to exit the Telephony Drivers dialog box.

3. Click on the Close button to exit the Telephony dialog box.

4. Exit the Control Panel.

Note:  Remember to restart Windows if you selected the TCM TelAdaptor as your Interface device and you
have not already restarted Windows.

Configuration of Nortel’s TAPI SP 1.5 is complete.  You are now ready to install and setup your TAPI
application.



52  •  Chapter 3  Configuring Nortel’s TAPI SP 1.5 Nortel Symposium Desktop TAPI Service Provider 1.5
User’s Guide



Nortel Symposium Desktop TAPI Service Provider 1.5 Chapter 4  Troubleshooting Tips  •  53
User’s Guide

Chapter 4  Troubleshooting Tips

This chapter provides information for additional installation acceptance testing using the TAPI Test Tool and
for running the Logger Tool.  In addition, it also describes possible problems and the actions to resolve these
problems.

Verifying Nortel’s TAPI SP 1.5 is Installed and
Configured Properly

The TAPI Test tool (Tapitest.exe) is provided to assist you in verifying that Nortel’s TAPI SP 1.5 is properly
installed and configured.  Alternately, Microsoft “Dialer” application provided with Windows 95, can also be
used to dial a call and verify that Nortel Symposium Desktop TAPI Service Provider 1.5 is up and running.

Note:  If you are having problems, you may be instructed to run the TAPI Logger program while using the TAPI
Test tool.  The “Logger Troubleshooting Tool” section provides information on running the TAPI Logger
program.  However, do not run the TAPI Logger program unless instructed to by Nortel’s TAPI Support
Personnel.

Using the TAPI Test Tool

The TAPI Test Tool (Tapitest.exe) is a utility program provided by Northern Telecom to help test the
installation of Nortel Symposium Desktop TAPI Service Provider 1.5.

Successful installation of Nortel Symposium Desktop TAPI SP 1.5 displays a program group named Nortel
Symposium Desktop TAPI SP (Windows 95) and Symposium Desktop TAPI SP program group window
(Window 3.x) on your computer that contains the TAPI Test Tool icon. Launching the TAPI Test program
displays the TAPI Test window.  This window provides you with the capability to answer, make, and drop calls,
to place calls on hold and take them off hold, and to transfer calls.  The call information is displayed in the fields
on the Call Information area.  The Log Information area displays the log information.  Successful completion of
these tasks ensures the Nortel TAPI SP 1.5 is installed and configured properly.

Launching the TAPI Test Tool:
If the operating system on your computer is Window 95, you launch Tapitest.exe by clicking on the Start
button, selecting Programs, then selecting the Symposium Desktop TAPI SP program, and choosing
NTTAPISP TAPI Test.



54  •  Chapter 4  Troubleshooting Tips Nortel Symposium Desktop TAPI Service Provider 1.5
User’s Guide

If the operating system is Window 3.x, open Symposium Desktop TAPI SP program group window and double-
click on the NTTAPISP TAPI Test icon.

Launching the TAPI Test program opens the TAPI Test window.

TAPI Test Window
The TAPI Test Tool provides a windows-based user interface that allows you to launch Nortel's TAPI SP 1.5
and perform simple testing.  The TAPI Test window contains the following window elements:

The following table describes the window elements contained on the TAPI Tool window.
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Table 12  TAPI Test window elements and descriptions

Elements and their Description

Title bar :  Contains the name of the window and the means to minimize, maximize, move, and close the window using the
window icons or the Control menu box.

              

Menu bar:  Contains the menu option for the Logger application.  Clicking on a menu provides the list of options for that
menu.

Call Information area :  Displays the current call's information.  Any new call becomes the current call.
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Table 12, cont.

Elements and their Description

Log Information area:  Displays the log information.

               

Working with the TAPI Test Tool
To Use the Test Tool:

1.  Launch the TAPI Test Tool program by double-clicking on the TAPI Test Tool icon located in the
Symposium Desktop TAPI SP program group (Windows 95) or in the Symposium Desktop TAPI SP
program group window (Windows 3.x).

The TAPI Test dialog box is displayed.

2. Choose a log file name to store the log information
Select the Log… option on the File menu to display the list of log files.
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The information in the Log Information area is saved in the default log file "logfile.txt" unless you
specify a different name.

3.  Launch Nortel's TAPI SP 1.5 by selecting the Start option on the Provider menu.
The launch information is displayed in the Log Information area.

Note:  When the contents, in the Log Information area, exceed 10 kilobyte, then this information is
appended to the log file automatically.

4.  Perform call activities to ensure Nortel's TAPI SP 1.5 is working properly.  For example, select the
Make call option on the Phone menu and enter the number to call on the Input Number dialog box.
The current call information is displayed in the Call Information area.  Any new call, inbound or
outbound, becomes the current call.
The Log Information area displays information regarding the activity.

The Phone menu provides options to select a call from the Call List as the current call (Select), answer
a call (Answer), make a call (Make Call), drop the current call (Drop), place the current call on hold
(Hold), and take the current call when on hold off hold (Unhold).

5.  If Nortel's TAPI SP 1.5 is working properly, close the TAPI Test Tool by selecting the Exit option on
the File menu.
Or
If there is a problem with performing any of the call activities, then recheck the installation (Chapter 2)
and configuration (Chapter 3) information.  If you are still having difficulties, refer to the additional
information in Chapter 4 "Trouble Shooting Tips" or contact the Support Personnel for Nortel
Symposium Desktop TAPI SP 1.5.  Refer to the "Technical Support for the Nortel Symposium Desktop
TAPI SP 1.5" section located in Appendix A.

Using Other Applications

The Nortel Symposium Desktop TAPI Service Provider works with many applications.  Some of these
applications include the Nortel Symposium products of Call Manager, Multimedia Conferencing, FastCall,
FastView, and Communicator.  In addition, Nortel’s TAPI SP works with Microsoft Outlook 97 and the
Microsoft Window Dialer.  Brief information is provided in this section for using Microsoft Outlook 97 and the
Window Dialer.  For information on the Nortel Symposium products, refer to the user documentation provided
with the application.

Using Microsoft Outlook 97
If you have Microsoft Outlook 97 version 8.02.4212 or above loaded on your machine, you can use it with the
Symposium Desktop TAPI SP.  However, Symposium Desktop TAPI SP does not support Microsoft Outlook
97, so problems must be addressed with Microsoft.  In addition, Symposium Desktop TAPI SP does not provide
the Microsoft Outlook 97 software.  This software is located on Microsoft’s Web site.

The information presented here is for general purposes only and intended only as a guide in using Microsoft
Outlook 97 with the Symposium Desktop TAPI SP.  For specific Microsoft Outlook 97 information, refer to
Microsoft Outlook 97 user documentation.

To Configure Microsoft Outlook 97:

1.  Ensure the Symposium Desktop TAPI SP software in installed, configured, and working (refer to the
“Verifying Nortel’s TAPI SP 1.5 is Installed and Configured Properly” section located in Chapter 4)
and that Microsoft Outlook 97 is loaded on your machine.
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2.  From the Contact folder, go to the Tools menu and select Option.
The Options dialog box is displayed.

3.  Click on the Dialing Option…  button.
The Dialing Options dialog box is displayed.



Nortel Symposium Desktop TAPI Service Provider 1.5 Chapter 4  Troubleshooting Tips  •  59
User’s Guide

4.  Click on the arrow located to the right of the Connect using line drop down listbox to display the
options.

5.  Select your line instead of the modem.

6.  Make any additional changes to the Dialing Properties as desired.

7.  Click on the OK  button to save the changes and close the Dialing Options dialog box.

Note:  Use the Contact Manager in Microsoft Outlook 97, not the Contact Manager in Scheduler.

Using the Windows Dialer
The Dialer application is provided in the Windows directory.

To Use the Dialer:

1. Double-click on the Dialer.exe program located in the Windows directory.

2. Select a line number to control from the drop-down list.
The keypad is displayed.

3. Dial a know working number that can be answered.  A completed call verifies that the Nortel’s TAPI
SP 1.5 is working correctly.

Logger Troubleshooting Tool
During installation or while running an application, problems might occur that can not easily be found through
normal running of the application.  The Logger troubleshooting tool provides run time information from the
service provider in great detail.  When requested to by technical personnel, creating a log file provides
information that assists in troubleshooting problems.

The Logger troubleshooting tool presents information in the Logger window that can be stored in the overflow
file for review by technical personnel.  When a troubleshooting session is started you should always clear the
overflow file.  This will ensure that no old information from a previous session is being saved.

When the troubleshooting session is completed you should append the information to the overflow file.  This
ensures all information from the current session is saved.

Launching the Logger Troubleshooting Tool

Note:  Run this application only when requested to by Nortel’s TAPI SP 1.5 technical personnel.

If the operating system on your computer is Window 95, you launch Logger.exe by clicking on the Start button,
selecting Programs, then selecting Symposium Desktop TAPI SP program, and choosing NTTAPISP Logger 16.
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If the operating system is Window 3.x, open Symposium Desktop TAPI SP program group window and double-
click on the NTTAPISP Logger 16 icon.

Launching the Logger Troubleshooting Tool opens the Logger window.  After launching the Logger, starting a
TAPI application, such as the TAPI Test Tool, displays information in the Logger window.

Logger Window

The Logger Troubleshooting tool provides a window-based user interface that allows you to view, edit, and print
the text displayed in the Logger information display area.  The Logger window provides menu options for using
the Logger application.   The window toolbar provides access to certain options without accessing the menus
and selecting the option.  The Logger window contains the following window elements.

The following table provides a description of the window elements contained on the Logger window.
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Table 13  Logger window elements

Window Elements and their Description

Title bar :  Contains the name of the window and the means to minimize, maximize, move, and close the window using
the window icons or the Control menu box.

          

Menu bar:  Contains the menu option for the Logger application.  Clicking on a menu provides the list of options for
that menu.

               

Display area:  Presents information that assists in troubleshooting problems.  This information can be saved to a file.

                     

Using the Logger Troubleshooting Tool

To Display the Logged Information in the Logger Window:

1. Run the Logger Trouble tool.  Refer to the “Launching the Logger Troubleshooting Tool” section.
The Logger window opens.

2. Clear the Overflow file.  The overflow.log file is located in the c:\NORTEL\NTTSP\Drivers  directory
if you accepted the default directory destination during installation or in the Drivers folder located in
the directory you selected during installation.

a. Click on Options located on the Menu bar of the Logger window.
The Options menu is displayed.

b. Click on the Clear Overflow File option.

3. Start the TAPI application.
The Event and Error messages are displayed on the Logger window.



62  •  Chapter 4  Troubleshooting Tips Nortel Symposium Desktop TAPI Service Provider 1.5
User’s Guide

To save the specific information during the troubleshooting session, you must save it to a .log file.

To Save the Information to a File:

When the troubleshooting session is over, append the information to the Overflow file.

Note:  The Logger window has a limited capacity for holding information.  The information in the
Logger window may not be saved when the TAPI application is terminated.  Append the
information to the Overflow file to avoid losing the information.

1. Click on Options located on the Menu bar of the Logger window.
The Options menu is displayed.

2. Click on the Append Overflow File option.

Or
Use the Save As option to save the information to a file.

1. Select the Save As option on the File menu.
Or
Click on the Save icon located on the Toolbar.
The Save As dialog box is displayed.

2. Enter the file name and directory path.

3. Click on the OK  button or press <Enter> save the file and close the Save As dialog box.

The Troubleshooting log is saved to the file.
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To Print the Information on the Window:

To print the complete window text:

Select the Print  option on the File menu.
Or
Click on the Print icon located on the Toolbar.

The complete window text is printed.

To print only selected window text:

1. Select the text that is to be printed.
The selected text is highlighted.

2. Select the Print  option on the File menu.
Or
Click on the Print icon located on the Toolbar.

The selected text is printed.

Nortel’s TAPI Compatibility
The following figure shows TAPI Compatibility

Figure 5  TAPI Compatibility
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Nortel’s TAPI SP 1.5 Process Flow for Install and Setup
The following process flow for install and setup provides information on how the Nortel Symposium Desktop
TAPI 1.5 sets up and works.  This information assists in troubleshooting Nortel’s TAPI SP 1.5.

1) After completing the installation of Nortel Symposium Desktop TAPI SP, the following files
have been installed:

C:\Nortel\Nttsp\ Help.txt
Readme.txt

C:\Nortel\Nttsp\Drivers\ Accdrvr.ipe, Accdrvr.m23, Accdrvr,tm, Accdrvr.viu, Init.exe,
Logger16.exe, Nttd.386, Tapiconv.dll, Tapitest.exe, Waccsrv.dll,
Xlatesig.tm, Xlatesig.viu

C:\Windows\ Nttapisp.ini, Visit.ini

C:\Windows\System\ Drvrflex.dll, Phstp.dll, Linkdriv.dll, Linkttas.dll, Waccsrv.dll,
Accevlog.dll, Cfgmgr.dll, Xlatesig.dll, Vaccwin.exe, Vaccess.tsp,
Visitdrv.exe

Nttapisp.ini should look like this:

[Service Provider]

Directory=C:\WINDOWS\SYSTEM\
DriversDir=C:\Nortel\nttsp\
Version=1.5.0.XX

2) After completing the installation of Nortel Symposium Desktop TAPI SP, the following files
have been installed if there were no Microsoft TAPI files on the machine. (Win 3.1 or Win 3.11)

C:\Windows\System\Telephon.cpl, Tapi.ddl, Tapiaddr.dll, Tapiexe.exe, Telephon.ini

3) After completion of Install, going into the Telephony Control Panel uses the Telephon.cpl file to
setup the TAPI SP.

4)  Adding the Nortel TAPI SP modifies the Telephon.ini file by adding Vaccess.tsp to the list of
Service Providers.

After first installing the NT TAPI SP on a system running Win95 the beginning portion of the
Telephon.ini file will appear as follows:

 [Providers]

NumProviders=2
NextProviderID=3
ProviderID0=1
ProviderFilename0=unimdm.tsp
ProviderID1=2
ProviderFilename1=VACCESS.TSP

 [Provider1]

NumLines=1
NumPhones=0

[Provider2]

NumLines=1
NumPhones=0
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Note:  If the customer needs to retain use of the unimdm.tsp service provider for use of Hyper
Term, Dial-Up Network, Phone Dialer, etc. change the preceding lines to appear as follows:

[Providers]

NumProviders=2

NextProviderID=3

ProviderID0=1

ProviderFilename0= VACCESS.TSP

ProviderID1=2

ProviderFilename1=unimdm.tsp

[Provider1]

NumLines=1

NumPhones=0

[Provider2]

NumLines=0

NumPhones=0

5) Selecting Interface device uses Drvrflex.dll and Cfgmgr.dll and exiting and saving saves to
Nttapisp.ini and Visit.ini.

a) Selecting MCA or MPDA or Communicator Card, or TelAdapt with SL1 copies Accdrvr.tm
to Windows/System/ as Accdrvr.dll and saves to Nttapisp.ini and Visit.ini.

b) Selecting MCA or MPDA or Communicator Card, or TelAdapt with SL100 copies
Accdrvr.ipe to Windows/System/ as Accdrvr.dll and saves to Nttapisp.ini and Visit.ini.

c) Selecting VIU copies Accdrvr.viu to Windows/System/ as Accdrvr.dll and saves to
Nttapisp.ini and Visit.ini.

6) Selecting Telephone Parameters button uses Phstp.dll and Cfgmgr.dll to copy to Nttapisp.ini the
phone set buttons configured.

7) Selecting M2317 phone set copies Accdrvr.m23 to Windows/System/ as Accdrvr.dll and saves
to Nttapisp.ini and Visit.ini.

8) Setting ACD, SCCS, or PBX/Switch… parameters uses Phstp.dll and Cfgmgr.dll to copy to
Nttapisp.ini for Reason Codes, ACD information, and SCCS information.

9) Using the TAPITEST program creates a logfile called Logfile.txt in the C:\Nortel\Nttsp\Drivers
directory.

10) Using the Logger program creates a logfile called Overflow.log in the C:\Nortel\Nttsp\Drivers
directory.

11) Initialization of the TAPI SP on Meridian 1 will update and change the Nttapisp.ini file with any
differences it sees in the download of keys from the switch.
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The following is an example of this file after initialization:

[Service Provider]

Directory=C:\WINDOWS\SYSTEM\
DriversDir=C:\Nortel\nttsp\
Version=1.5.0.XX

[Voice Device]

VoiceDevice=MCA
VoiceDevicePort=1
VoiceDeviceSwitch=SL1
BaudRate=2400
Parity=None
StopBits=1
DataBits=8

[Telephone]

SetType=MDT
NumReasons=5
SetDN=LDN8078-1
SetName=Jon Hansen
Language=English
SetModel=M2616
DNIS=0
RFLA=0
AAA=0
TransferRetries=5
CallForcing=0
AutoHandsFree=0
AutoInspect=1
PrimeDN=0
DisplayRows=2
DisplayCols=24
SoftkeyRows=0
SoftkeyCols=0
NumKeys=16
AddOn1=none

[Reason1]

ReasonCode=4
ReasonName=F

[Reason2]

ReasonCode=5
ReasonName=B
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[Reason3]

ReasonCode=6
ReasonName=N

[Reason4]

ReasonCode=7
ReasonName=P

[Reason5]

ReasonCode=9
ReasonName=T

[Codes]

ParkRetrieve=172

[Key1]

KeyType=DN
KeyTypeName=singleCallRinging
KeyTypeCode=78
DNName=Jon Hansen
DNNumber=LDN8078-1
DNPriority=1
DNForwardAllowed=1

[Key2]

KeyType=DN
KeyTypeName=singleCallRinging
KeyTypeCode=78
DNName=Line 2
DNNumber=5079
DNPriority=1
DNForwardAllowed=0

[Key3]

KeyType=Auto Dial
KeyTypeName=autoDial
KeyTypeCode=10

[Key4]

KeyType=Spd Call
KeyTypeName=speedCallUser
KeyTypeCode=80
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[Key5]

KeyType=Call Fwd
KeyTypeName=forward
KeyTypeCode=33

[Key6]

KeyType=Transfer
KeyTypeName=transfer
KeyTypeCode=85
DNName=Transfer
DNNumber=XFER_DN
DNPriority=7
DNForwardAllowed=0

[Key7]

KeyType=Make Busy
KeyTypeName=makeSetBusy
KeyTypeCode=47

[Key8]

KeyType=Other
KeyTypeName=unknown
KeyTypeCode=0

[Key9]

KeyType=Conf 6
KeyTypeName=conference6
KeyTypeCode=21
DNName=Conference 6
DNNumber=CONF6_DN
DNPriority=9
DNForwardAllowed=0

[Key10]

KeyType=Call Park
KeyTypeName=park
KeyTypeCode=66

[Key11]

KeyType=Display
KeyTypeName=inspect
KeyTypeCode=41
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[Key12]

KeyType=Auto Dial
KeyTypeName=autoDial
KeyTypeCode=10

[Key13]

KeyType=Auto Dial
KeyTypeName=autoDial
KeyTypeCode=10

[Key14]

KeyType=Auto Dial
KeyTypeName=autoDial
KeyTypeCode=10

[Key15]

KeyType=DN
KeyTypeName=singleCallRinging
KeyTypeCode=78
DNName=Line 3
DNNumber=8804
DNPriority=1
DNForwardAllowed=0

[Key16]

KeyType=Other
KeyTypeName=unknown
KeyTypeCode=0

Note: On MSL-100 or DMS-100, no switch download is performed.  The only method of setting
all keys to correct feature is via the control panel telephone setup.

12) If any of this fails to occur please contact your customer support group.

Nortel’s TAPI SP 1.5 Application Error Recovery
The following error messages could occur when you start your Nortel’s TAPI SP 1.5 applications.

• The TAPI Line Initialize Call failed.
Error Code = 80000048

• Failed to get device capabilities.

• Line cannot be initialized.
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Note:  On Meridian 1, if the switch is data filled as 2008 and you are using a 2616 with a TelAdaptor, the TAPI
SP will not initialize.

If you get an ‘Initialization error, refer to the “Line Initialization Error” section.

If you receive any of the above messages, try the following error recovery procedures.

• Make sure your phone is working and is not deactivated.

• Be sure the light is on and flashing on the MCA or on the MPDA.

• Check the interface device connections to the PC.

• Verify that you have selected the correct interface device, COMM ports, Switch type, and telephone
type and that the keys were assigned properly during TAPI SP Setup (see
Chapter 3).

• Restart Windows and try again.

• Uninstall and then re-install Nortel’s TAPI SP 1.5.

Problems

TAPI Fails to Initialize

Problem:

After installing Nortel’s TAPI SP 1.5 and TAPI fails to initialize, the Microsoft TAPI system files may be
missing or may not be the latest version.  If this is the case, they need to be installed and the TAPI Service
Provider must be installed into TAPI. However, this process can vary greatly from one Windows version to
another.

 First and foremost, be sure to do version checking when installing all files.

 Second, use a setup application rather than relying on an .INF file to install Microsoft TAPI. While the ATSP
sample uses an .INF file to install, there are several major problems with using an .INF file:

• TAPI needs to already be installed (which is not guaranteed under Windows 3.1 or Windows for
Workgroups).

• You can not do operating system version checking if you use an .INF file.
• You can not do file version checking with an .INF file.
• Bugs that won't be fixed in Windows NT 4.0 prevent an .INF file installation.

Third, once all the Microsoft TAPI files are installed, the Nortel’s TAPI SP 1.5 must now be installed into
TAPI.   Refer to the “Installing  Nortel’s TAPI SP 1.5 Software” section for information on installing Nortel’s
TAPI SP 1.5.

Files Necessary for Windows 3.1 or Windows for Workgroups
 When a TAPI Service Provider is installed under Windows 3.1 or Windows for Workgroups, all the necessary
system files must be present. Some of these files are optional and some are not.  Here is a list of files and where
they should be placed:
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Mandatory TAPI files:
• TELEPHON.CPL [system]
• TAPI.DLL     [system]
• TAPIADDR.DLL [system]
• TAPIEXE.EXE  [system]
• TELEPHON.HLP [system]

Optional TAPI files:
• ATSPEXE.EXE  [system]
• ATSP.TSP     [system]
• ATSP.HLP     [system]
• DIALER.EXE   [windows]
• DIALER.HLP   [windows]

Files Necessary for Windows 95 and Windows NT 4.0
 The Microsoft TAPI 1.3 redistributable files are only for use on Windows 3.1 and Windows for Workgroups.
These files must not be installed to any other operating systems. Other Windows operating systems either do not
support Microsoft TAPI (Windows NT 3.51 and earlier) or come with Microsoft TAPI (1.4) already installed
(Windows 95, Windows NT 4.0 and later versions of both platforms).

 One complication for Windows 95 is the TELEPHON.CPL file. This file is installed to the system directory by
default along with all the rest of the Windows 95 TAPI files. However, because this file is not needed by most
people using Windows 95, it is installed in the system directory as TELEPHON.CP$ to reduce control panel
clutter. First look in the system directory for TELEPHON.CPL; if that is not found, locate TELEPHON.CP$
(also looking in the system directory), and rename it to TELEPHON.CPL.

Line Initialization Error

Problem:

If running a TAPI Application causes a "Line Initialization error" or the functions of the TAPI
Application do not seem to be working, re-check your interface device cable connections and the TAPI
Service Provider configuration.  However, you may also need to remove other TAPI Service Providers
as indicated in the workaround below.

Workaround:

Remove all other Telephony Drivers, for example, TAPI Service Providers.  Double-click on the
Control Panel’s Telephony icon, click on the unwanted Driver, and click on the Remove button.
Restart Windows.

The Installed Drivers list must include the Nortel TAPI SP entry only.

Telephone.ini Workaround:

After first installing the NT TAPI SP on a system running Windows 95 the beginning portion
of the Telephon.ini file will appear as follows:

[Providers]
NumProviders=2
NextProviderID=3
ProviderID0=1
ProviderFilename0=unimdm.tsp
ProviderID1=2
ProviderFilename1=VACCESS.TSP
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[Provider1]
NumLines=2
NumPhones=0

[Provider]
NumLines=1
NumPhones=0

If you need to retain use of the unimdm.tsp service provider for using the Hyper Term, Dial-
Up Network, Phone Dialer, or others, change the preceding lines to appear as follows:

[Providers]
NumProviders=2
NextProviderID=3
ProviderID0=1
ProviderFilename0= VACCESS.TSP
ProviderID1=2
ProviderFilename1=unimdm.tsp

[Provider1]
NumLines=1
NumPhones=0

[Provider2]
NumLines=0
NumPhones=0

This tip is applicable to any Nortel Symposium product that utilizes Nortel’s TAPI Service
Provider to provide an interface to an Nortel phone (for example,  Nortel Symposium Call
Manager, Multimedia Conferencing, FastCall).

Operation Failed Error

Problem:

Receiving an OPERATION_FAILED error indicates an attempt to perform a function that the switch
does not allow.  For example, the switch does not complete a conference while one party is ringing.  It
is up to the application how handle this.  The TAPI returns the result code as OPERATION_FAILED if
the function AddToConference is called before the pending conference is answered.

Workaround:

In the example, make sure the call is answered and then add to the conference.  Generally, try the
function again.

Using Meridian TelAdaptor TCM with Non-compatible IBM PC

Problem:

Nortel’s Meridian 1 TAPI Service Provider 1.5 is not compatible with IBM Microchannel PC (PS/2)
using the Meridian TelAdaptor TCM as the interface device.
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Workaround:

Microchannel PCs will work with Meridian Communication Adapters (MCA), Meridian Programmable
Data Adapters (MPDA) and VISIT Interface Units (VIU).

Install and configure one of the above devices as your interface device instead of the TelAdaptor.

Problems with MCA Connectivity

Problem:

 If you have problems with the MCA connectivity device, the following Logger file contains
information when the MCA cable is not plugged in or when the MCA power supply is not plugged in or
has gone bad:

1 : vaccmain :  149:Diagnostic DLL' Loaded Tick: 109895
 1 : vacclin2 : 1628:TSPI_lineNegotiateTSPIVersion : Tick 109909
 1 : vacclin2 : 1647:OK : Tick 109911
 1 : vaccprov :  656:TSPI_providerEnumDevices : Tick 109913
 1 : vaccprov :  660:OK : Tick 109914
 2 : vaccprov :  738:InitTimeoutSeconds is 60000 ms
 1 : vaccprov :  747:TSPI_providerInit : Tick 109938
 1 : vaccprov :  749:InitTimeOut: 60000
 1 : vaccprov :  750:Free space 0x1bc9000
 0 : vaccwin  :  350:7334
 1 : vaccprov :  835:Applet window handle 0x1cc
 1 : vaccprov :  838:Applet task handle 0x258e
 2 : vaccwin  :  254:WM_VACC_START Tick 109995
 2 : drvstart :  133:Inspect timer ticks: 5 0x5
 0 : accutils :  566:MCA not connected or powered
 2 : accints  : 1355:Bad status from OpenCommPort 64
 0 : accmain  :  256:InitDriver failed
 0 : accmain  :  340:AccInstall failed
 0 : ntapi    :  104:InitialiseDriver failed
 1 : vaccwin  :  103:mWinRegister: 9
 0 : vaccprov :  224:WM_VACC_START result: 0x3e6 Aborting Provider initialization
 1 : vaccprov :  869:OPERATIONFAILED : Tick 110775
 0 : vaccmain :  558:At the very end of the wep for vaccess Tick: 110778

Workaround:

Check that the MCA cable is plugged in and the power supply is turned on and connected to the MCA.

Problems with MPDA Connectivity

Problem:

The MPDA connectivity device is no longer available from Northern Telecom and you may experience
problems when using it.
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The following logger file contains information on an MPDA that is not compatible and will not
initialize:

1 : vaccmain :  149:Diagnostic DLL' Loaded Tick: 1914634
 1 : vacclin2 : 1628:TSPI_lineNegotiateTSPIVersion : Tick 1914648
 1 : vacclin2 : 1647:OK : Tick 1914652
 1 : vaccprov :  656:TSPI_providerEnumDevices : Tick 1914655
 1 : vaccprov :  660:OK : Tick 1914664
 2 : vaccprov :  738:InitTimeoutSeconds is 60000 ms
 1 : vaccprov :  747:TSPI_providerInit : Tick 1914701
 1 : vaccprov :  749:InitTimeOut: 60000
 1 : vaccprov :  750:Free space 0x17b2000
 1 : vaccprov :  835:Applet window handle 0x20c
 1 : vaccprov :  838:Applet task handle 0x2226
 2 : vaccwin  :  254:WM_VACC_START Tick 1914719
 2 : drvstart :  133:Inspect timer ticks: 5 0x5
 0 : accutils :  563:MCA powered DCD high
 1 : vaccwin  :  103:mWinRegister: 0
 1 : aries    : 3318:SMCtrl: STOP_SM and bCmdInProgress == FALSE
 1 : vaccmain :  227:Tue Sep 30 10:11:13 1997 (1915632)
 1 : accevlog : 1527:CTRL-Z
 1 : vaccmain :  227:Tue Sep 30 10:11:15 1997 (1917667)
 1 : accevlog : 1527:ATI1
 1 : vaccmain :  227:Tue Sep 30 10:11:15 1997 (1917755)
 1 : accevlog : 1527:ATI1
 0 : aries    : 1069:Unknown device attached ERROR
 1 : vaccmain :  227:Tue Sep 30 10:11:15 1997 (1918276)
 1 : accevlog : 1527:ERROR
 1 : aries    : 4505:Timeout waiting for msg: check continuity ?
 0 : accutils :  563:MCA powered DCD high
 1 : aries    : 4558:Init failed, starting retry 1 of 5

Workaround:

If you experience problems, we recommend that you upgrade to the MCA connectivity device.

TAPI Applications Do Not Display Correct Information

Problem:

If your TAPI Application does not display the correct calling number or calling party's name, the name
assigned to the line in the switch may need to be changed. The TAPI Service Provider may not deliver
the correct Calling number or name to the TAPI Application if the name is configured as indicated
below or the first letters in the name conflict with the Reason Codes defined under PBX/Switch
Parameters:
Name Format: Name + a space + a number
Example:  John Smith 2

Workaround:

From a M1 PBX Administration Terminal use LD 95 to change the name so that a space and number
do not follow the name.

Also, verify that the Reason Codes defined under PBX/Switch Parameters match the parameters
defined in LD 95 on the Meridian 1 PBX and do not conflict with the Name displayed for the calling
party.
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Problem:

In high traffic environments, when multiple calls are arriving at the same set at the same time you are
trying to dial out, some digits of the dial out string get lost.  For example, if you are dialing 932-1450,
your set may display 21450.

Workaround:

Add the following variables to the nttapisp.ini file under [Telephone]:
MaxCalls= defaults to 10, must be between 8 and 64
TxQueueSize= defaults to 100, raising may eliminate signals being dropped
RxQueueSize= defaults to 500, raising may eliminate signals being dropped
MaxEvents= defaults to 80, must be between 64 and 128

Problem:

In high traffic environments, when more calls are coming in faster than the system can handle, such as
when calls are coming in faster than one call every two seconds, the driver may report incorrect name
and number information to the TAPI application.

Workaround:

This is a limitation of the Symposium Desktop TAPI SP.

Problem:

Parked calls that return to the phone set may report incorrect calling name and number.  This occurs
when the calls are parked on a switch other than the switch where the call originates.

Workaround:

After unparking the call, hold and unhold the call and the display reports the correct information.

Problem with Multiple Appearance DN
Problem:

You encounter a problem putting a Multiple Appearance DN (Multiple Call Ringing DN) of a Meridian
Business set on a DMS-100/MSL-100 on Hold (using a TAPI application) after establishing a
conference.

Workaround:

After establishing the conference, pressing the Hold button on the set will work and the TAPI
application should still run fine.

Problem with Transfers
Problem:

You encounter a problem after putting Line 1 on hold and completing a blind transfer on another line,
attempts to answer a Multiple Appearance DN or Multiple Call Ringing DN fail from the TAPI
Application.

Workaround:

Pressing the DN key on the set will work and the application should still run fine.
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Problem:

Using a MBS 5209 set and attempting to do a blind transfer to a busy DN on a DMS switch, you are
unable to return to the original caller.  To clear, the controller must be restarted.

Workaround:

Use the supervised transfer.

Problems with Conference Calls
Problem:

You encounter problems establishing a conference call on the Active line 1 while line 2 is ringing.

Workaround:

Answer Line 2 and put it on hold before trying to establish a conference on line 1.

Problem:

The TAPI Service Provider limits the number of active conference calls.  You can toggle between lines
1 and 2 if they each have an active call on them or if either of the two have an active conference on
them.  However, TAPI SP does not allow both lines to have a conference on them.

Workaround:

Do not establish a second conference call with the TAPI Application.

Problem:

Including a parked call into a conference may cause incorrect reporting when one leg of the conference
drops off.

Workaround:

To get the original call information, hold and unhold the call.

Problem:

When conducting a three-party conference and one party drops out of the conference, the TAPI Service
Provider is unable to detect the dropped party until the three-party call is converted to a two-party call.
At this point, the remaining call is ACTIVE.

In rare cases, the switch may not report the correct ACTIVE call.  This can happen if a returned parked
call is subsequently used in creating a conference.  Parked calls that return to the phone set may report
incorrect calling name and number.  This occurs when the calls are parked on a switch other than the
switch where the call originates.

Workaround:

Before conferencing a returned parked call, HOLD and UNHOLD the returned parked call.  This
allows the switch to report the correct information and the problem is avoided.

In all cases, once all active calls are idle on a phone, the TAPI SP 1.5 reports correctly.

Problem:

Using your phone set and the application to complete a conference call may cause synchronization
problems.

Workaround:

We recommend that you use either the phone set or the application to complete conference calls.
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Problems with Parked Calls
Problem:

Parked calls that return to the phone set may report incorrect calling name and number.  This occurs
when the calls are parked on a switch other than the switch where the call originates.

Workaround:

After unparking the call, hold and unhold the call and the display reports the correct information.

Problem:

The Unpark feature does not work.

Workaround:

The Unpark feature is not supported in 16-bit.  Microsoft TAPI does not support the Line Unpark
feature in 16-bit version.

Problems Using the VISIT Interface Units
Problem:

If you are on an MSL-100/DMS Switch and are using MBS sets with the VISIT Interface Unit, you
may encounter problems if you also have a Light Span Concentrator on the line or if you are using
SLC-96.

Workaround:

There is no workaround for this problem at this time.

Problem with Closing Files
Problem:

If you are using Microsoft Windows 95 as your operating system with a Meridian TelAdaptor TCM
interface device, some files may not "gracefully" close when performing a shutdown on your PC.

Workaround:

You may need to manually turn off your computer after selecting shutdown in Microsoft Windows 95.

Nortel’s TAPI SP 1.5 files
When installing Nortel’s TAPI SP 1.5, the files are copied to the directories listed in Table 14 and 15 during
installation.  The directory listings assume that the default path C:\NTTSP was chosen during installation.
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Table 14  Listing of C:\Nortel\NTTSP and C:\Nortel\NTTSP\DRIVERS directories

Directory of C:\Nortel\NTTSP

     README.TXT

Directory of
C:\Nortel\NTTSP\DRIVERS

     ACCDRVR.IPE Copied to C:\WINDOWS\SYSTEM as ACCDRVR.DLL when 5317 TDX is
selected as the Interface device during TAPI SP Setup.

     ACCDRVR.M23 (Hayes Modem Driver—not currently supported) Copied to
C:\WINDOWS\SYSTEM as ACCDRVR.DLL when Hayes Compatible Modem
is selected as the Interface device during TAPI SP Setup.

     ACCDRVR.TM (Meridian Modular Telephone Driver)
Copied to C:\WINDOWS\SYSTEM as ACCDRVR.DLL when the TCM
TelAdaptor, the MCA, or the MPDA is selected as the Interface device during
TAPI SP Setup.

     ACCDRVR.VIU (VISIT Interface Unit Driver)
Copied to C:\WINDOWS\SYSTEM as ACCDRVR.DLL when the VISIT
Interface Unit is selected as the Interface device during TAPI SP Setup.

     ACCEVLOG.DLL (Logs Driver Events)
Copied to C:\WINDOWS\SYSTEM when you click on the Troubleshooting
button and choose a Debug mode of File or Windows during TAPI SP Setup.

     NTTD.386 (TelAdaptor support file)

     WACCSRV.DLL (Common portion of all drivers ACCDRVR.XXX) Always copied to
C:\WINDOWS\SYSTEM

     XLATESIG.TM (Signaling Translator for MMT sets)
Copied to C:\WINDOWS\SYSTEM as XLATESIG.DLL when you click on the
Troubleshooting button and choose a Debug mode of File or Windows during
TAPI SP Setup

     XLATESIG.VIU (Signaling Translator for MBS sets)
Copied to C:\WINDOWS\SYSTEM as XLATESIG.DLL when you click on the
Troubleshooting button and choose a Debug mode of File or Windows during
TAPI SP Setup.
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Table 15  Listing of C:\WINDOWS and C:\WINDOWS\SYSTEM directories

Directory of C:\WINDOWS

     NTTAPISP.INI (Contains Northern Telecom Specific Information such as):
-  Connectivity information (Interface device
    PC COMM Port)
-  Telephone Parameters (Key assignments)
-  Switch/PBX information
-  ACD Parameters
Most of this information is solicited from the user during the installation and
configuration process, but the file contains other information as well.

     TELEPHON.INI (Only installed if NOT present in C:\WINDOWS prior to installation of the
TAPI SP)

     VISIT.INI

Directory of C:\WINDOWS\SYSTEM

     ACCDRVR.DLL (Will only exist after TAPI SP Setup)

     ACCEVLOG.DLL (Debugging file, may exist after TAPI SP Setup)

     CFGMGR.DLL (Used during TAPI SP Setup to read and write configuration information to
NTTAPISP.INI)

     DRVRFLEX.DLL (Used during TAPI SP Setup when defining an Interface Device)

     LINKDRIV.DLL (TelAdaptor Support File)—See Note 2

     LINKTTAS.DLL (TelAdaptor Support File)—See Note 2

     PHSETUP.DLL (Used during TAPI SP Setup when defining Telephone, PBX/Switch, ACD and
Troubleshooting parameters)

     TAPI.DLL (TAPI File)—See Note 1

     TAPIADDR.DLL (TAPI File)—See Note 1

     TAPIEXE.EXE (TAPI File)—See Note 1

     TELEPHON.CPL (TAPI File)—See Note 1

     VACCESS.TSP (Main Nortel TAPI SP file)

     VACCWIN.EXE (Nortel TAPI SP Support File)

     VISITDRV.EXE (TelAdaptor support file)—See Note 2

     WACCSRV.DLL (Driver Support File)

     XLATESIG.DLL (Debugging file, may exist after TAPI SP Setup)

Note 1:  The files should not be deleted because they are TAPI.  The Nortel TAPI SP 1.5 installer simply makes
sure these files are available in case the PC does not currently have TAPI installed.

Note 2:  These files are all copied and run only if the TelAdaptor is configured as the interface device.  If the
TelAdaptor is selected as the interface device, these files can not be deleted because they are loaded in memory.
You must exit Windows to delete these files.
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Removing Microsoft TAPI 2.1 Software
If you are using Windows 95 with Microsoft TAPI 2.1 and want to install and use the Nortel Symposium
Desktop TAPI SP 1.5, you must uninstall the TAPI 2.1 software and reinstall your system’s original TAPI
system files.  This will install Microsoft TAPI 1.4.

To Uninstall TAPI 2.1 Software:

1.  Locate the file REMTAPI.INF for Windows 95, or REMTAPIN.INF for Windows NT.

2.  Right-click on the file, then click on "Install".

This will reinstall your original TAPI system files.

3. Place the TAPI.dll for Microsoft TAPI 1.4 in your Windows\System directory.

Note:  When you take Microsoft TAPI from 2.1 to 1.4, you must have a copy of the TAPI.dll for the 2.1 version.
This DLL can be obtained from a Windows 95 CD or from a machine that is already using the Nortel
Symposium Desktop TAPI SP 1.5.

This procedure will not work on a WIN NT machine.  This version of the Nortel Symposium Desktop TAPI SP
1.5 is not compatible with WIN NT.

Removing Nortel’s TAPI SP 1.5 Software
If it becomes necessary to remove Nortel’s TAPI SP 1.5 software, an Uninstall program is provided.  Running
the Un-Install program deletes the database files.

To Remove Nortel’s TAPI SP 1.5 Software:

1.  If you loaded Nortel’s TAPI SP 1.5 software from the Web site,  go to the directory where the file was
downloaded and double-click on the setup.exe file.
The Setup dialog box is displayed.
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2. Click on the Next button to continue removing the files.
The Select Installation: dialog box is displayed.

3. Click on the Un-install button followed by the Next button.

Nortel’s TAPI SP 1.5 software files are removed.
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Appendix A  Additional User Information

Appendix A provides additional user information.  This information includes how to receive technical support, a
summary of the online documents, and information on using the Adobe Acrobat Reader to view the online
documentation.

Technical Support for the Nortel’s TAPI SP 1.5
If you have difficulty when using the Nortel Symposium Desktop TAPI SP for Meridian 1 Release 1, help is
available in different formats.  This document provides troubleshooting tips in Chapter 4.  For telephone support
in the United States and Canada, contact your Nortel support personnel.

Technical Assistance (800) 527-0797
Product Information (800) 4-Nortel
Developer Support (800) NT4CTI0

Outside the United States and Canada, contact your Nortel Support or Sales representative.

Note:  If your copy of Nortel’s TAPI SP 1.5 was included as part of another application, we recommend that
you contact the application’s technical support as indicated in application’s documentation.

To resolve a Nortel’s TAPI SP 1.5 problem properly, Nortel field support personnel may require the following
information:

1. A description of the problem, sufficiently detailed to help Nortel reproduce the problem.  For example,
if the problem involves screen pops, the description should include not only what appears on the PC
monitor (TAPI application), but also what appears on the phone's display, with as much accuracy as
possible—including numbers, dashes, and names that appear on the top and bottom lines of the display.

2. A printout of the nttapisp.ini file, VISIT.ini, telephon.ini, and the autoexec.bat.

3. Printouts of certain switch datafill.  On Meridian 1, use LD 20 to print the TNB of the set, and on
DMS-100 or MSL-100, print the QLEN of the set.  Ask your switch administrator for these.

4. The switch software release number.  For the Meridian 1, indicate the X11 Rel. 19, 20, and so forth.
For the DMS-100 or MSL-100, indicate BCS 34, 35, and so forth.

5. Run the Logger troubleshooting tool to create and save a log file of the problem.

Overview of the Online Documentation
The User documents for Nortel’s TAPI SP 1.5 are provided electronically as online documents.  However, your
version of the Nortel Symposium TAPI SP 1.5 may or may not contain all of the available documents.  The
following chart provides the name of the document, the file name and a description:
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Document Name File Name Description

Nortel Symposium Desktop TAPI
Service Provider 1.5 User’s Guide

Usrguide.pdf This user’s guide provides information on installing,
configuring, and using Nortel’s TAPI SP 1.5.

Nortel Symposium Desktop TAPI
Service Provider 1.5 Programmer’s
Guide

Progvol1.pdf This document contains information that is helpful to
developers  who are writing applications that may use
Nortel’s TAPI SP 1.5.

Nortel Symposium Desktop TAPI
Service Provider 1.5 Planning Guide

implem.pdf This document contains the requirements for implementing
Windows TAPI compliant applications.

The Adobe Acrobat Reader must be installed to access the online documentation.  After installing the Adobe
Acrobat Reader, double-clicking on the .PDF file opens the online document in the Acrobat Reader window.

Overview of the Adobe Acrobat Reader

The Acrobat Reader Window

The Acrobat Reader window contains menus, tools, and buttons.  The Menu bar of the Acrobat Reader window
displays the Help menu.  The Help menu contains important information on how to view and print the
document.  The Toolbar on the Acrobat Reader window provides tools for working with the documents.  Select
a tool by clicking the icon.
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Using Bookmarks on the Acrobat Reader Window

The online documents contain bookmarks to assist you in finding information.  Selecting the Bookmark button

 provides an automated table of contents.

The Bookmarks are displayed on the left of the window.

Clicking on the Expand icon  located to the left of the bookmark displays additional topics in a tree-view.
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When the additional topics are displayed, the Expand icon changes to the Collapse icon.

Clicking on the Collapse icon  removes the additional topics.
Clicking on a Bookmark takes you directly to the page containing the information.

Using Links on the Adobe Acrobat Window

The Table of Contents, Index, and certain words or phrases provide direct links to the page associated with the
entries.  Links are red boxes that enclose a page number or word.  Clicking on the red box displays the page that
contains the information.
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In addition, certain pages reference additional information.  When these references are enclosed in a red box,
clicking in the box displays the referenced page or document.

Clicking on the Back button  displays the previous page.
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Appendix B  Supported Features

Appendix B identifies the features that the Nortel Symposium TAPI Service Provider supports.

Nortel’s TAPI SP 1.5 Feature Support
TAPI applications can do screen pops (database queries of a Calling or Called number) by using information
delivered by Nortel’s TAPI SP 1.5.  Nortel’s TAPI SP 1.5 receives the information from the M1 Option 11-81
PBX via the following configuration.

1. Receipt of IANI digits (Calling numbers) only from Telco over IANI enabled DID or Tie trunks that
auto-terminate at an ACD DN (Agents set).

2. Receipt of CLID digits (CLID-Calling number) only from Telco or private network over ISDN PRI
trunks that have CLID enabled.

3. Receipt of DNIS digits (Called number) only from Telco over DID or Tie trunks that auto-terminate at
an ACD DN Agents set or are routed via the Incoming Digit Conversion (IDC) feature to specified
ACD DNs base on the dialed number.

4. The combination of configurations 2 and 3 above allows screen popping on Calling number (via ISDN
PRI/CLID) and Called number (via DNIS) simultaneously.

Nortel’s TAPI SP 1.5 delivers Calling Party Name Display and Network Calling Party Name Display
information if provided over ISDN PRI trunks to TAPI applications.

Nortel’s TAPI SP 1.5 also supports ACD Call overflow and interflow.

Nortel’s TAPI SP 1.5 also supports Message Waiting Indication, if configured on the set.

Note:  When an ACD agent transfers a call that has already received the Calling/Called number, the party that is
receiving the transferred call will also receive the Calling/Called number (because M1 passes along the CLID
and DNIS digits); giving the appearance of an Agent-to-Agent screen transfer.  TAPI applications that do screen
popping find this useful.

Nortel’s TAPI SP 1.5 currently supports the features listed in the “Features Supported on the Meridian 1/SL-1”
and  “Features Supported on the MSL-100/DMS-100” sections.
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Features Supported on the Meridian 1/SL-1

Features Nortel’s TAPI SP 1.0 Nortel’s TAPI SP 1.5

Make Call Yes Yes

Answer Call Yes Yes

Hold and Un-hold call Yes Yes

Blind Transfer Yes Yes

Supervised Transfer Yes Yes

Conference Call (3 party & 6 party) Yes Yes

Consult Call Yes Yes

Ring Again (Activate & Cancel) Yes Yes

Call Pickup Yes Yes

Call Park (Park & Retrieve Park) Yes Yes

Call Forcing * Yes Yes

* Meridian 1 PBX only

Features Supported on the MSL-100/DMS-100

Features Nortel’s TAPI SP 1.0 Nortel’s TAPI SP 1.5

Make Call Yes Yes

Answer Call Yes Yes

Hold and Un-hold call Yes Yes

Blind Transfer Yes Yes

Supervised Transfer Yes Yes

Conference Call (6 party) Yes Yes

Consult Call Yes Yes

Ring Again (Activate & Cancel) Yes Yes

Call Pickup Yes Yes

Call Park (Park & Retrieve Park) Yes Yes
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Glossary of Terms

ACD

Automatic Call Distribution.  This is a telephone system feature that automatically routes calls to agents.

ANI

Automatic Number Identification.  This is another name for call ID (CLID).  ANI is typically a 10-digit number
that is delivered by the network to identify the incoming caller.

CLID

Caller identification.  This is another name for ANI.

CTI

Computer Telephony Integration.

DNIS

Dialed Number Identification Service.

DNs

Directory Numbers.

IDC

Incoming Digit Conversion.

MBS

Meridian Business Set.

MCA

Meridian Communications Adapter.

MMT

Meridian Modular Telephone.

MPDA

Meridian Programmable Data Adapter.



92  •  Glossary of Terms Nortel Symposium Desktop TAPI Service Provider 1.5
User’s Guide

Nortel Developer Support Hotline

For additional information or help, call (800) NT-4CTI-0.

SCCS

Symposium Call Center Server

Service Providers

Software files needed to enable TAPI applications to communicate with the physical telephony device.

SP

Service Providers.

TAPI

Telephony Application Programming Interface.

VISIT FastCall

A windows-based Computer Telephony Integration (CTI) program for small call centers that makes handling
calls in telephone-intensive environment faster and more reliable.

VIU

VISIT Interface Unit.
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